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PREFACE

Welcome to the Operator’s Manual for Conviron’s Central ManagementTM (CM) System. This 
Manual has been developed to assist those responsible for remotely monitoring and operating 
Conviron growth chambers. The Manual is provided to all clients who have purchased a 
chamber(s) with Central ManagementTM.

The manual is structured to provide step-by-step instructions. Clients will find sufficient detail 
including figures, diagrams, and graphics to remotely monitor and operate the chamber without 
issue. However, given that installations are specific to each facility and that facilities may have 
unique circumstances, additional information or assistance from Conviron may be required. In 
such cases, contact information is provided on the following page. 

This equipment is only to be used by authorized personnel – that is, personnel who have been 
trained on the proper use of the equipment and who have read this manual.
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SERVICE AND TECHNICAL SUPPORT
Conviron welcomes the opportunity to provide assistance and to answer any technical 
questions related to the start-up, use and general technical support and troubleshooting of 
the Central ManagementTM system. Before contacting Conviron, please check the following:

•	 Read this Operator’s Manual in its entirety for information about the feature(s) with which 
you are experiencing trouble.

•	 If the problem persists and/or you require additional assistance, please collect the 
following information prior to contacting Conviron:

•	 Serial Number - The serial number of Central ManagementTM is located on the serial 
card on the side of the computer or on the Installation Media.

•	 Software version number of Central ManagementTM – Open Central 
ManagementTM and Select “Help” then “About”. A dialog window will open, 
showing the software version number. 

•	 A description of the problem.

•	 A description of what you were doing before the problem occurred.

Head office
Technical Services 

Conviron 
590 Berry St.  

Winnipeg, Manitoba, 
Canada R3H 0R9

Conviron Technical Services

North America Europe

Toll free +1.800.363.6451 +44.(0).800.032.6422

Telephone +1.204.786.6451 +44.(0).1638.781.731

Fax +1.204.786.7736 +44.1638.741.112

Email info@conviron.com service@conviron.eu
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EULA - CONVIRON LICENSE AND WARRANTIES FOR 
CENTRAL MANAGEMENT TM SOFTWARE AND HARDWARE
Controlled Environments Limited, Controlled Environments Inc., Conviron Europe Ltd., and 
Conviron Germany GmbH, all hereinafter referred to as Conviron.

Software Licence
The Central ManagementTM software (the “Software”) which accompanies this End User 
License Agreement (the “Agreement”) is the property of Conviron or its licensors and is 
protected by copyright law. While Conviron is the legal and rightful owner of the Software, 
you will have certain rights to use the Software following your acceptance of this Agreement. 
Except as may be modified by an Addendum to this Agreement, your rights and obligations 
with respect to the use of this Software are as follows:

You may:

(i)	 Use one copy of the Software on a single computer;
(ii)	 Copy the Software onto the hard disk of your computer and retain the original for archival 

purposes; and
(iii)	 After written notice to Conviron, transfer the Software on a permanent basis to another 

person or entity, provided that you retain no copies of the Software and transferee agrees 
to the terms of this Agreement. Your license shall be terminated at the time of transfer.

You may not:

(i)	 Copy the documentation which accompanies the Software;
(ii)	 Sub-license, rent, lease or assign any portion of the Software;
(iii)	 Reverse engineer, decompile, disassemble, merge, modify, translate, make any attempt to 

discover the source code of the Software, or create derivative works from the Software; or 
(iv)	 Use a previous version or copy of the Software after you have received a disk 

replacement set or an upgraded version as a replacement of the prior version.

Warranty for Central ManagementTM Software
Conviron warrants the Software and media for a period of ninety (90) days from the date of 
installation or one hundred and twenty (120) days from the date of shipment from the factory, 
whichever comes first, provided the Software is delivered to you by Conviron, or to a Conviron 
authorized distributor or agent. This warranty applies only if you are the original licensee of this 
copy of the Software.  Conviron warrants that the media on which the Software is distributed 
will be free and clear from defects during the warranty period stated above.

Conviron warrants that the Software, if unaltered, will conform to its program specifications 
during the warranty period stated above.  This warranty shall only apply where the Software 
is properly used on a computer for which it was designed. Your sole remedy in the event of 
a breach of this warranty will be that Conviron shall, at its option, make the Software and/or 



June 2011 | Revision 2.4iv

media operate as warranted by making the necessary corrections or replacing the Software 
and/or media with functionally equivalent Software and/or media, or terminate your license 
and refund the money paid by you for the Software and/or media, upon return of all of your 
copies of the Software. Conviron does not warrant that any other defects will be corrected or 
that the operation of the Software will be uninterrupted or error-free.

Conviron’s obligation under this warranty is void in its entirety if the Software is improperly 
installed, abused, misused, neglected or altered, or if damaged by flood, fire, or any act of God. 
Any re-configuration of the Software without the prior consent of Conviron shall be considered 
tampering and will void the warranty in its entirety. Where the Software cannot perform properly 
due to conflicts with user installed software or hardware, this warranty shall not apply.

Warranty for Central ManagementTM Hardware
Conviron warrants Central ManagementTM hardware against defects in components or parts 
for a period of twelve (12) months from the date of acceptance, or fourteen (14) months 
from the date of shipment from the factory, whichever comes first. Conviron will replace or 
repair at its option, without charge, such defective parts or equipment. Conviron’s obligation 
under this warranty is void in its entirety if the equipment is improperly installed, or is in any 
way abused, misused, neglected, or altered, or if damaged by fire, flood, or acts of God, 
or if the serial number plate has been altered, defaced, or removed.  Freight and labor 
charges incurred in replacing or repairing such defective parts are included in the coverage 
provided by the warranty.  The customer is responsible for all customs and duty charges 
where applicable. Conviron shall not be liable for any loss or damage, including incidental or 
consequential, due to operation failure of the Central ManagementTM PC or its components.

THE ABOVE SOFTWARE AND HARDWARE WARRANTIES ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING THE 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NON-INFRINGEMENT.

Disclaimer of Damages
In no event shall Conviron (including its directors, officers, employees and agents) be liable 
for any special, consequential, indirect or similar damages, including but not limited to 
any lost profits or lost data arising out of the use or inability to use the Software or Central 
ManagementTM PC, even if Conviron has been advised of the possibility of such damages. 
Some jurisdictions do not allow the limitation or exclusion of liability for incidental or 
consequential damages, so the foregoing limitation or exclusion may not apply to you. In no 
case shall Conviron’s liability exceed the purchase price for the Software, media, and/or Central 
ManagementTM PC.

General
This agreement shall be governed by the laws of the Province of Manitoba, in Canada, with the 
courts of the Province of Manitoba having exclusive jurisdiction.
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PRECAUTIONS

 
The following symbols are used throughout this manual to draw your attention to important 
warnings, guidelines and product information. Please take note of their respective meanings.

	 	 	

	Hazard Warning	 Important Information	 Please Note

Please note the following Hazard warnings before operating this equipment:

•	 Users of Central Management™ must be aware that changes they make will impact 
electrical and/or mechanical operations of a chamber(s) at a location that they are 
not visually monitoring and/or physically present at. 

•	 Operating the chamber remotely, while others are occupying or servicing the 
chamber, COULD BE HAZARDOUS AND MAY RESULT IN PERSONAL INJURY to 
service or other on-site personnel.  As such, manipulation of parameters via CM 
must only be performed when Users have taken appropriate safety precautions 
including having established that NO ONE ELSE is occupying or servicing the 
chamber while using CM software.  

•	 Conviron Central Management™ is normally the connection point to several external 
alarm monitoring systems. Consequently, it is important to understand the following;

1.  Users of CM must have permission to connect to CM and if the work requires 
rebooting or shutting down the equipment, the onsite authority must be 
informed such that this procedure can be accomplished safely.

2.  Be certain of the correct procedures for remote connection, login and disconnect. 
It is possible to select the incorrect “quit” methodology and “shutdown” the CM 
system rather than simply disconnecting the remote connection. If the system is 
shutdown, all subsequent chamber alarms occurring would not be recognized by 
CM, thereby failing to send out alarm notifications.  Once shutdown, the CM system 
would require a manual startup. 

3.  While the CM system shows many of the chambers’ parameters, alarm settings 
and physical conditions are not available to the remote user. Any type of change 
or diagnostics are best performed when onsite personnel are available to work 
with the remote user.

•	 Central Management™  is an optional feature. If Central Management™  is being 
used it becomes inextricably linked to the use of the Controller and therefore, both 
the Central Management™ Manual and the Operator’s Manual for the Controller 
must be read and understood in their entirety prior to operation.
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1.0 INTRODUCTION
This Manual explains how to use the Conviron Central ManagementTM (CM) system to 
remotely monitor and operate Conviron growth chambers based on CMP series Controllers. 
It is intended for people who are responsible for managing and / or operating the growth 
chambers within their facility, but who are not expert users of Microsoft Windows.

This Manual contains seven chapters.

Chapter 1.0 Introduction
Describes the organization of the Manual, its document conventions, the major features of 
the Central ManagementTM system, and how to contact Conviron Client Services.

Chapter 2.0 Quick Start 
Explains how to get started. Instructions are provided including setting up the computer 
and chamber network and using the Central ManagementTM application, along with a brief 
outline of the user interface. A step by step approach has you working right away. It also 
describes how to get online help and further assistance. 

Chapter 3.0 Using Central ManagementTM

Explains how to use all Menu functions including adding chambers and subscribers to the 
Central ManagementTM Network, organizing chambers in folders, planning experiments, 
viewing Activity Logs and Extracting data or alarms.

Chapter 4.0 Chamber Activities
Outlines the necessary day to day activities in a work flow format to aid the Administrator 
in using the software effectively. Included are; Monitoring chambers using the Thumbnail 
Status, Email Alerts, Chamber Panel and Viewing alarms and configuring responses. 

Chapter 5.0 Remote Chamber Programming
Describes how Users access and work with the Central ManagementTM system and Chambers 
from Network, Internet locations and alternate devices.

Chapter 6.0 System Maintenance and Troubleshooting
Describes the necessary details for the configuration of backups, Central ManagementTM 
system settings, Alarm responses and network addressing, and restoration of Central 
Management™ software.

Chapter 7.0 Central Management™ Software Installation
Provides instructions on learning how to install the Central ManagementTM v8.1 software-only 
component of Conviron’s Central ManagementTM system.
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Glossary of Terms used in this Manual.

1.2 Document conventions
To help you find and understand information, the following document conventions are used 
in this Manual.

Table 1.1: Conventions

Convention Meaning

Tip: Information that isn’t procedural, but will help with the use of  
Central ManagementTM.

Important: Information that is essential to performing a procedure.

Bold text The name of a section in this Manual or another Manual.

Italic text The name of the file or directory.

Typewriter font Text that you enter.

“In Quotes” Menu names and menu selection options

key1+key2 Press and hold the first key while you press the second key.

key1, key2 Press and release the keys sequentially.

1.3 Central ManagementTM system features
The Central ManagementTM system is a Microsoft Windows based remote control and 
monitoring application for Conviron growth chambers equipped with CMP series Controllers. 

Using Central ManagementTM, you can operate and monitor growth chambers from a central 
location. The Central ManagementTM system makes it possible for Conviron Client Services to 
perform maintenance and troubleshooting tasks remotely.

Central ManagementTM system features
Using Central ManagementTM, you will be able to perform the following tasks remotely:

•	 Tell, at a glance, the status of any chamber on the network
•	 Operate all chambers on the network from a central location
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•	 Receive Email Alerts for Urgent alarms
•	 Download alarm and log data in text or “csv” format
•	 Gain online access to Central ManagementTM system using Windows Terminal Services
•	 Take advantage of Central Management™’s built-in Web Reporting service

The Central ManagementTM System includes the following software and optional hardware.

•	 Central ManagementTM software v8.2

Optional Central ManagementTM hardware
•	 Pentium processor 
•	 8 GB RAM 
•	 2TB hard drive 
•	 19 inch monitor
•	 Conviron Restore Drive
•	 Dual 10/1000Base-T Ethernet cards
•	 Sanity Card ensures fail-safe operation
•	 DCS - Dry Contact Alarm Reporting System
•	 Microsoft Windows Operating System

The hardware for the Central ManagementTM system reflects current PC 
technology, including Conviron’s additions of Conviron Flash Drive imaging and 
Restore, Sanity / Alarm card, Dry Contact System (DCS), dual Network cards with 
three display monitor capability, and Daily Automated Backup. A single 19” LCD 
display is standard.

Central ManagementTM hardware options
•	 Autodialer
•	 Modem
•	 Networking components
•	 Switches
•	 Wiring
•	 Cabling transport
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Central ManagementTM software features

•	 The Central ManagementTM system has all the features of the previous Central Control system 
(CCS) with many additions to meet the changing needs of our clients. 

•	 Central ManagementTM is a .NET 2.0 application. The application runs on Windows 
2000™, Windows XP Professional™, Windows 7.

•	 The Central ManagementTM “core”, (CMService.exe) runs as a system service (it is not tied 
to a user account) allowing multi-user security access. Central ManagementTM is the User 
Interface and may be closed, without effect to logging, alarms, or email.

•	 Central ManagementTM is network independent. Addressing can conform to Users’ needs 
to permit integration and coexistence in existing Networking Structures (some restrictions 
apply to legacy equipment).

•	 Direct online Central ManagementTM system access via network or optional modem using 
generic Windows Terminal Services on PCs or Macs and Microsoft Windows Mobile 
2003SE on PDAs. 

•	 Windows 7 operating system shares PC resources more efficiently, allowing the Central 
ManagementTM PC to be a fully functional workstation.

•	 Central ManagementTM software can run on Client hardware without the Conviron’s 
hardware option, however, the Local Audible alarm, Sanity reset, Autodialer and Building 
dry contacts options for Alarm alerting would not be available. Email Alerts in this 
situation would be the only alerting method.

•	 Central ManagementTM has a built-in Web Reporting service. This provides Status 
Thumbnails, Data and Alarm logs, Trend-Graphing, Service History and Data downloading 
to a remote user via a Web Browser. It is perfect for the view-only people who need to see 
what the chambers are doing. Web Reports are available anywhere via Internet or Intranet 
Web browsers.

•	 A full featured calendar based Experiment Scheduler documents the start-stop date, 
chamber ID, User Name, Experiment Name and notes. Information is presented on a 
Gantt style or grid chart display. 

•	 The Scheduler tool has Chamber Usage tracking and reporting by Chamber or User, for 
charge out purposes. Reports are printable or may be saved in text and html formats.

•	 Central ManagementTM’s chamber properties record contains editable fields of ID, Model, 
Serial, Notes, Service History, Service Notes, Experiments, Subscribers and a 12 character 
description field. The chamber database keeps all the related items to a chamber and 
experiment together in one place.

•	 The email alarm reports are “configurable”, allowing you to determine which alarm will 
generate an email alert. The email system is organized for a single “Network subscriber” 
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who gets every chamber alarm message and individual “chamber subscribers” who see 
only alarms from their particular chamber(s). An Email Alert message links to the Web 
Report Alarms page for that chamber.

•	 Trend graph allows for instant multi-day, (up to 1 year) multi-point graphs and printouts, 
(optionally) including alarm condition indicators.

•	 Files are stored on the Central ManagementTM system in standard Comma Separated 
Values (CSV) format. Files are organized by chamber ID, in DataLog, Alarmlog and 
Programs directories. The data file is stored as a daily archive and filename-branded with 
“year - day of the year – Chamber # “   (i.e. - 07124001.log) format.

•	 Dry Contact System has a programmable reset interval to prevent masking of second and 
tertiary alarm actions.

•	 Configurable settings for Email, Web Reports, Dry Contact System, and Alarm Actions are 
flexible to work the particular environment. 

•	 Easy test verification features for Email, Dry Contact System and Sanity.
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Protection

The Conviron hardware includes Microsoft Security Essentials. As Virus protection is vital for 
any internet connected PC, it is strongly advised that an Anti-Virus program is installed. The 
Conviron Central ManagementTM system includes Microsoft Security Essentials, by default. 
As most clients have an existing preference for an Anti-Virus program, please be sure to 
read Chapter 6 regarding Central ManagementTM’s requirements and Third Party Security 
protection. Restore and Backup operations are explained in detail in Chapter 6, pages 22-26.

Networking

The Chambers and Central ManagementTM system do not have special requirements for 
networking hardware. Connecting the chambers with a local private network is the default 
installation type. Expanding or connecting to the building services can be added at any 
time, as the Central ManagementTM system is ready for the additional connection. The 
second Building Network card is set to auto-configure (DHCP). Details on configuring TCP/
IP networking with the Central ManagementTM system are found in Chapter 6.0

Online Assistance

Conviron Client Services offers online assistance with all our products, and this is facilitated 
by our ability to connect to your Central ManagementTM system network. This can be via the 
Internet (analog modem optional) or LAN connections, whichever is appropriate for your 
IT Building Services to supply. For your security, take note that we use several static TCP/IP 
addresses for Internet connections to your facility. These addresses can be added to your 
firewall rules, allowing secured access to Central ManagementTM: 207.54.102.226 primary 
and 207.54.102.229 secondary.

Customization

The decision that must be made, is how the Central ManagementTM system is to be 
used in your specific environment. This can wait until all the features and possibilities 
are understood, within the framework of the users’ workflow. The Email, Remote 
Communication and Web services can be activated at any time by adding the necessary 
settings to Central ManagementTM’s “settings panel”. See Section 1.3: Central 
ManagementTM system features to select the options that best fit your needs.
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References
This Central ManagementTM Operator’s Manual explains how to use Central ManagementTM. 
If you need assistance using Microsoft Windows, a Conviron Controller, or any of the other 
software applications included with the Central ManagementTM System, refer to one of the 
following user guides:

•	 Microsoft Windows User’s Guide

•	 Conviron CMP4030 User’s Guide

•	 Conviron CMP5090 User’s Guide 

•	 Conviron CMP6050 Operators Manual

•	 Conviron CMP37660 User’s Guide (3000 Host)

CMP4000, CMP4030, CMP5090 and CMP6050 are trademarks of Controlled Environments Limited.

Conviron is a registered trademark of Controlled Environments Limited.

Microsoft, Excel, Windows and Windows 7 are registered trademarks of Microsoft Corporation.
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2.0 QUICK START
The Central ManagementTM program runs in the Windows Operating System so you need a 
basic understanding of how to work with Windows applications. Central ManagementTM can 
be run on Windows 2000, Windows XP Pro and Windows Vista Ultimate. Microsoft .NET v2.0 
is required.

This chapter is intended for readers who have little experience with a Central ManagementTM 

system or Windows. In this chapter, you will learn:

•	 How to setup the Central ManagementTM hardware

•	 To understand the features and startup mode

•	 To Login as Administrator or Guest

•	 How to start and quit Central ManagementTM

•	 About the Central ManagementTM system

•	 To setup your Chamber Network

•	 How to get online help

2.1 PC Hardware setup
Connect items in the following sequence; refer to Figure 2.1: Rear Panel View.

Table: 2.1: Connection checklist

Item

1 Connect monitor and PC power cables to power bar.

2 Connect monitor, mouse and keyboard to PC.

3 Connect ethernet cables to chamber network, PC and switch.

4 Connect building network cable to PC and building services. (Optional)

5 Connect Dry Contact System cable to PC and DCS box.

6 Connect DCS to autodialer and/or building alarm system. (Optional)

7 Connect modem cable to modem and the other end to phone outlet. (Optional)

8 Connect autodialer to modem “phone jack” (Optional)
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Figure 2.1: Rear Panel View
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To merge into a building network the addressing scheme must be disclosed 
and Conviron equipment preconfigured with static network addresses.

The CMP4000 to CMP5000 Controllers have several possible Ethernet 
LAN configurations, but there are certain restrictions. These options are 
available only with the Controller software version 6.22

2.2 Network Description
•	 Inter-connections between the Chamber Controllers (CMP4000, CMP5000 and CMP6000) and 

the Central ManagementTM system PC utilize industry standards to ensure that a proven network 
technology is provided for the Conviron Chamber Network.

•	 Conviron, by default, provides a private network for the chambers and Central 
ManagementTM system. The hardware and equipment is non-proprietary and can coexist 
in most TCP/IP based Ethernet networks.

Conviron Controller Ethernet LAN Configurations
The Chamber may be:

1.	 Integrated into Client’s network as fixed (static, not DHCP) IP address in the existing 
User’s LAN address scheme.

2.	 Integrated into user’s network as separate subnet, using a private addressing scheme, 
but connected to the user’s LAN hardware.

3.	 Connected to Client’s network via a router, allowing the physically separate hardware 
and addressing schemes to communicate to each other.

4.	 Connected to Client’s network via a Central ManagementTM system, allowing the 
physically separate hardware and addressing schemes to communicate to each other 
(Conviron Default).



June 2011 | Revision 2.42-4

CHAPTER 2.0 | QUICK START

Central ManagementTM Networking
Connect the Chamber and Central ManagementTM PC to the Ethernet switch using the same 
ethernet cabling as the Chamber. 

Click on Start” > “Control Panel” > “Network and Internet” > “View network Status and 
tasks” > “Change Adapter Settings”.

Right click on the Chamber Network 
and Select “Properties”. The “Network 
Properties” screen will be displayed.

Scroll down and select Internet 
Protocol Version 4 (TCP/IP), then 
click on the “Properties button”, 
Figure 2.1a: Internet Version 4 
Protocol Properties will be displayed.

The Building Network connection is 
optional and must be configured by 
on site I.T. staff.

The Central ManagementTM system 
is installed with 192.168.0.100 as the 
default Network address. Chambers 
also default to 192.168.x.xx for 
Central ManagementTM Network, but 
their address must be set, so each 
Chamber has a unique ID (address).

Assuming the first Chamber is set 
to 192.168.0.1 (Unit ID 001) set each 
Chamber to have sequential IDs. 
(1,2,3 ...and so on). We reserve the first 
(100) addresses for legacy chambers, 
CMP4000 and CMP5000. The 
remaining addresses of 192.168.0.101 
to 254 are suitable for selection for 
CMP6050 Chamber Controllers.

Figure 2.1a: Internet Version 4 Protocol Properties
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CMP4000-5000 networking
To set the Chamber Addressing:

1.	 Power up the Chamber’s Controller. Once you see the chamber status screen, 
touch the Options icon and locate the Group and Unit numbers.

2.	 Touch the group and unit 
buttons, Figure 2.3: Group 
and Unit Address, to set the 
Controller’s Group to “0” 
and Unit ID to “1-99” or the 
desired TCP/IP address.

3.	 Once the Group and Unit 
are set, ‘Touch’ the “EXIT” 
button, to save the change 
and exit.

4.	 A pop-up window will  
appear warning “Net  
Address changed you must 
cycle power”. “Select” OK 
to proceed. After the restart 
the new Unit ID will be 
shown on the Controller status display,  
Figure: 2.2 CMP5090 Status Display.

Addressing format requirements:

IP address is 192.168.x.yy 
x is the first digit of the address (Group). Range is 0 to 9 
yy are the last two digits of the address (Unit). Range is 1 to 99 
Subnet mask is fixed at 255.255.255.0

Setting the Unit ID to 001 will set the TCP/IP address of the chamber 
to 192.168.0.1.

Remember, the chamber must be set to an address in the same network (x) 
as the Central ManagementTM PC (default - 192.168.0.100).

Figure 2.2: CMP5090 Status display

Figure 2.3: Group and Unit address
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CMP6050 networking
The CMP6050 can be connected to a Central ManagementTM system on an Ethernet Local 
Area Network. To enable communications the Controller must be connected to the network 
and configured with a suitable network address. There are two places where the Controller IP 
addresses must be set-up: At the Controller and at the Central ManagementTM PC.

There are two network addresses to set in the CMP6050:

•	 CMP Address:	 Address or ID of the Controller within the network.
•	 Netmask:	 Divides an IP address into subnets and specifies the network’s 

available host.
•	 Central ManagementTM	 Enables or Disables CM communication
•	 CM Address	 Central ManagementTM IP Address

A valid IP address is needed for the “CM Address” value when there is a 
Central ManagementTM system present. If there is no Central ManagementTM 

system present the CM Address should be set to ‘Disabled’.

To set the Chamber Addressing:

1.	 From the status screen, touch the ‘ID’ button  to access the network 
configuration, Figure 2.4: CMP6050 Network Configuration.

Figure 2.4: Network Configuration

Up

Enter

Down

Figure 2.4a: Controller Keys
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2.	 To change the address numbers touch each 
individual numerical field. A pop-up keypad, 
Figure 2.5: Keypad will appear each time a 
field is accessed.

3.	 Once all the addresses have been entered, 
touch the ‘EXIT’ button, Figure 2.5a: Exit 
and a pop-up warning window, Figure 2.6: 
Save Changes will appear to confirm the 
numerical entries:

4.	 Touch the ‘Yes’ or ‘No’ button to return to the 
Status Screen. Touch the ‘Cancel’ button to 
return and re-enter any numerical address errors.

Figure 2.5: Keypad 

Figure 2.6: Save Changes 

Figure 2.5a: Exit

If “Disabled” is displayed, Select the “Disabled” text and use the “Scroll Up” 
arrow key to change “Disabled” to “Enabled”, then press “Enter” to save. 
(Figure 2.4a: Controller Keys)
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2.3 Startup and Logon

Start-up
When the PC is powered on, it will automatically start the Central ManagementTM service. 
No user interaction is required. Data logging and alarming sequences are handled by the 
Central ManagementTM service, which is always operating when the PC on. 

Logon as Administrator
After a power outage, the PC will power up automatically starting the Operating System and 
the Central ManagementTM service. The user must logon with “conviron” ID.  

Administrator Logon
The administrator logon is “conviron” with the password “CWxxxx” where xxxx is the work order 
of the Central ManagementTM system as printed on page (i) of the Central ManagementTM 

system Installation Manual. If this information is lost, please contact Conviron Client Services, 
with your Central ManagementTM system serial number (located on the Central ManagementTM 
system side panel). The “conviron” logo allows the user to run Central ManagementTM system 
which permits full access to the chambers and management of all chamber related information.

Configuration
Conviron provided hardware will be pre-configured to a site’s existing chamber list (if known). 
Software installations will need to add chambers to the Central ManagementTM system list to 
enable communications with the Central ManagementTM system.

2.4 Starting and Quitting Central Management™
Your system has been preconfigured to automatically run Windows and the Central 
ManagementTM software whenever you start the computer.

Normally the Central ManagementTM Service is ALWAYS active, however the Central 
ManagementTM Operator Application can be started when required and closed when not needed.

For software updates and specific service tasks the Central ManagementTM Service may need 
to be stopped and restarted. Refer to Chapter 6 for details. 
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Starting the Central ManagementTM application
To start the Central ManagementTM application program:

•	 Double-click the Central ManagementTM icon  Central ManagementTM will start.

Quitting Central ManagementTM

There are two ways to quit Central ManagementTM. Either

•	 From the “File” menu, choose “Exit”. or

•	 Double-click the   button in the top left corner of the Central 

ManagementTM program’s window. Central ManagementTM will stop running.

2.5 Understanding the Central ManagementTM program window

Menu bar
The menu bar runs along the top of the window and provides access to all of the application’s 
commands, Figure 2.7: Central ManagementTM Status Display.

Figure 2.7: Central ManagementTM Status Display

Thumbnail DisplayMenu Bar

Actions Menu 
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Chamber status
The Chamber Status Thumbnails window displays the current status of each growth chamber 
currently connected to the network, Figure 2.7: Central ManagementTM Status Display. You 
organize chambers in “folders” and access them by clicking the Chambers List displayed on 
the right portion of the window. (See Chapter 3.0  Using Central ManagementTM, Organizing 
chambers in folders, for directions on using folders.) 

Thumbnail
Individual Thumbnails display the current status of all chambers connected to the network.

From a chamber’s thumbnail you can read the chamber’s zone selectors and alarm status. 
(See Chapter 3.0 Using Central ManagementTM, Understanding chamber status thumbnails 
for more information about reading thumbnails.), Figure 2.8: Thumbnail Display.

Actions List
Actions comprises a list of the most used commands for working with Central 
ManagementTM. If hidden, click on the roll-up button to reveal the entire menu.

Action List rolled up 

Virtual Login window
Right-click on a chamber thumbnail display to activate the chamber menu, Figure 2.8a: 
Chamber menu.

Select “Virtual Chamber” to login and work with the chamber Controller. The display seen 
will be different depending on the Chamber Controller type (see Sections 4.5, 4.12 for details).

2.6 Adding a Chamber to the Status Display

Figure 2.8:Thumbnail Display

009-sn:092030
TEMP HUM CO2LIGHT_uMOL

33.5
33.3 45

45
500
494

1500
1507

Chamber Menu

Figure 2.8:a Chamber Menu
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1.	 From the Central ManagementTM’s “Action Menu”, choose 
“Edit Chambers”. The “Edit Chambers” window will open.

2.	To add a new chamber select “Add New”.

3.	Type the Chamber ID number as shown on the Chamber 
Controller, then tab to set Model Serial, Controller, Notes 
and Display Name.

4.	Both the Chamber ID and the Controller entry is essential for 
Central ManagementTM to function properly with differing 
Conviron Controllers.

5.	Enter the Controller type as: CMPxxxx where the x= the four 
digit numeric model of your Chamber.

6.	To edit any record in the Edit Chambers window, select 
the entry and type in the new information Figure 2.11: Edit 
Chambers Dialog.

The Chamber specifications are especially useful in the notes area. Chamber ID and 
Controller are the only REQUIRED entries. 

CMP5000  
Interface

CMP6000  
Interface

Figure 2.9: Virtual chamber displays

Figure 2.10: Edit chambers
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The Display Name Entry will be shown on the Thumbnail Display of both Web reports and 
Central ManagementTM’s “dashboard”. The Display Name can be 12 characters or less.

To remove a Chamber entry, click on the column in front of the Chamber ID. Once the row is 
selected, press the delete key on the keyboard.

2.7 Getting Online Help
Central ManagementTM includes a PDF (Adobe portable document format) copy of the 
Operators Manual that can be opened at anytime.

From the menu bar

To access online help from the menu bar

•	 From the Help menu, choose Help.

The online help table of contents appears.

From within a remote control session

To access online help from a Remote Control or Virtual Login.

•	 Click the  button, or from the Help menu, choose Help.

The Help file will open to the table of contents.

Figure 2.11: Edit Chambers Dialog
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2.8 Known Issues
•	 When installing Central ManagementTM software, ensure the default installation location 

is used, C:\Program Files for 32 bit installations and C:\Program Files (x86) for 64 bit 
installations. This will avoid a potential Central ManagementTM Service startup failure.

•	 Ensure the Windows Regional and Language settings are set to English Canada. This 
prevents serious Program Editor Spreadsheet errors with time and units.

•	 The “Edit User” window has “Username” and “Email” entries. Both must not be empty. If 
no Email address is provided, insert a blank space.

2.9 Arranging Windows
While working with Central ManagementTM, you can arrange windows on the Central 
ManagementTM system desktop any way you want. Refer to Microsoft’s Windows User’s Guide 
for detailed instructions on moving, sizing, and arranging windows.

Minimizing windows

You can also save space on the desktop by shrinking open windows into icons or minimizing 
the window.

•	 Click  to minimize the window to a taskbar button. To restore the minimized window to 
its previous size, click its taskbar button.

Maximizing windows

To maximize an icon into a window

•	 Click  to maximize the window so it covers the full screen.

Arranging windows

You can re-arrange windows.

•	 After maximizing a window, click  to restore the window to its previous size.

To learn more about using Windows, refer to the Microsoft Windows Help and Support 
Center. Microsoft includes a self-paced tutorial with Windows. To start the tutorial

From the Windows Start menu,  choose Help and Support
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2.10 Typical Central ManagementTM screens

Figure 2.12: Central Management™

Figure 2.13: Web reports
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Figure 2.14: Virtual chamber (Remote Interface for 
CMP4000/5000 series Controllers)

Figure 2.15: Remote control (Remote Interface for CMP6000 series Controllers)
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Figure 2.16: Email alert

Figure 2.17: Central ManagementTM service
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Figure  2.18: Experiment scheduler

Figure  2.19: Trendgraph
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3.0 USING CENTRAL MANAGEMENTTM

Central ManagementTM provides the ability to work with alarm actions to ensure alerts are 
noticed effectively. Logged data can be opened in other applications such as spreadsheets 
and text editors.

In this chapter, you will learn how to:

•	 Understand all Menu Functions

•	 Add Chambers to the network

•	 Add Subscribers

•	 View Activity Logs

•	 Use Diagnostics

•	 Acknowledge / Respond to Alarms

•	 Schedule Experiments

•	 Extract Data or Alarms

•	 Export Alarm and Data to another application or file

All menu item functions are explained in this section. For detailed use and 
workflow suggestions, read chapter 4.0 Chamber Activities

3.1 Actions Panel

Edit chambers
Select Edit Chambers to Add/Remove a chamber or alter the 
key information about an existing chamber record, Figure 3.1.

Figure 3.1: Actions menu
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Add/edit

Select “Add New” and type 
in the Chamber ID number as 
set in the Chamber Controller, 
then tab to Model, Serial, 
Controller and Notes. The 
Controller entry is essential 
for Central ManagementTM 
to function properly with 
differing Conviron Controllers. 
Enter The Controller type as: 
CMPxxxx where the x= the four 
digit numeric model of your 
Chamber Controller, Figure 
3.2: Edit Chambers.

 

Tip: The Chamber specifications are especially useful in the notes area. Chamber ID and 	
Controller are the only REQUIRED entries.

Edit folders

Select “Edit Folders” from the actions menu to create and 
maintain custom chamber groups, Figure 3.3” Edit Folders.

Select “New Folder” 
then type your custom 
folder name. Custom 
folder names will 
be displayed in the 
lower section of the 
“Chambers” panel, 
Figure 3.5: Chambers 
Folders.

Next select a folder 
name, highlight 

chamber(s) and then click “Add” or “Remove” to 
update that folder’s list, Figure 3.4 Folder Editing.

OK to exit and save changes.

Figure 3.4: Folder Editing 

Figure 3.2: Edit Chambers

Figure 3.3: Edit Folders
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The first two categories are system defaults and may not be 
altered. Selecting “Show All” will display all configured chamber 
Thumbnail displays on the Status Display. Selecting “Active 
Alarms” will display on the Status Display, only the chambers that 
currently have active alarms.

User folders
The remaining categories are user defined and some examples 
of organization are shown here. A newly installed system will 
not have user defined entries, until they are defined, Figure 3.5 
Chambers Folders.

Edit users
Select “Edit Users” from the actions menu, Figure 3.6: Actions - 
Edit Users. Adding users to the Central ManagementTM allows the 
Central ManagementTM Administrator be able to alert the correct 
persons responsible for chamber activity, alarms and performance.

Usage reports and Email functions require the chambers to have 
users associated to them. The Email address is optional, but Email 
configuration must be completed for the Email Alerts to become 
functional, Figure 3.7: Edit Users. See sections 5.1 and 6.4 for 
additional email setup.

Figure 3.5: Chambers Folders 

Figure 3.6: Actions
Edit Users 

Figure 3.7: Edit Users
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Extract data
Extract data selection will allow you to choose where to copy the file and specify the Chamber 
ID, Start and End Dates and the data type, Alarms or Logs.

	 1.

	 2.

	 3.

	 4.

First, 
Select the chamber

Second, 
Select the start date.

Third, 
Select the end date.

Fourth, 
Select the data type, 
alarm or log files.
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	 5.

	 6.

Once you have chosen the location, type the filename and select one of the available 
formats, Excel Ready (CSV) or Tab delimited (Print Ready).

Scheduler

The Chamber Scheduler is a powerful Management interface to all Chamber information. 
Select “Scheduler” from the Action menu, Figure 3.9: Actions Menu.

Fifth, 
Select extract.

The “Save As” dialog 
box permits you to save 
the extracted Data to 
any device or location 
connected to the 
Central ManagementTM 
computer, Figure 3.8: 
Data Extract Dialog.

Figure 3.8: Data Extract Dialog

Figure 3.9: Actions Menu
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Figure 3.10: Scheduler Gantt View 

Two views are available for the schedules. The Gantt (above) and the grid (below). Both views 
can be configured to suit your needs. The Tool bar has two items from the Actions menu for 
convenience. (Edit Chambers and Users), Figure 3.10: Scheduler Gantt View.

Experiments are more than records of Chamber usage. They document the User, Chamber 
and any informative notes that are pertinent to the scheduled experiment. The start and stop 
dates assist the Administrator in determining the duration of all experiments (reports are 
by Chamber or by User). Detailed instructions are found in chapter 4.0 Chamber Activities, 
Figure 3.11: Scheduler Grid View.

Figure 3.11: Scheduler Grid View
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Ack all alarms

This Global command will acknowledge all alarms for all 
Chambers on the network. Acknowledging alarms indicates 
that you have “seen” the alarm condition and subsequent 
corrective action, if any, is your responsibility.

Acknowledging active alarms stops the local audible alarm 
and email notification as well as changing the state of the 
chamber display icons of the System tray, Thumbnail display 
and Chambers panel, Figure 3.12: Ack All Alarms.

Reset DCS
Selecting “Reset DCS” will deactivate the relay of the Conviron 
Alarm Contacts box, during an Alarm condition. It will set the 
N.C. (normally closed) contacts, back to a closed position and the 
Green LED (normal) will be illuminated. This feature is provided 
for backward compatibility with autodialer settings used in CCS 
versions 4, 5 and 6. This function would only be needed, when 
the “DCS reset interval” is set to 0 (disabled) or during the Dry 
Contact System reset interval, Figure 3.13: DCS Reset.

Activity log 
Select Activity Log, from the Action Menu, to review all Central 
ManagementTM  related network events, Figure 3.14: Activity Log.

Remote Chamber Connections, Email Alarms and tests, Central 
ManagementTM  Service status, Dry Contact System Relay Status, 
Sanity Status and Chamber Communications are all examples of 
the message types stored in the Activity Log. The files are located 
in the C:\Program Files\CM\ActivityLogs for 32 bit installations 
and C:\Program Files (x86)\CM\ActivityLogs for 64 bit installations 
directory. The files are date coded for mm/dd/yy.log

Figure 3.12: Ack All Alarms

Figure 3.13: DCS reset

Figure 3.14: Activity log
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Figure 3.15: Chambers Panel

Alarm Icons 
Three types of Icons precede the log message to inform you of the urgency of the log entry. 
These icons also appear in the Chambers panel, folders list, indicating the alarm status of the 
individual folder groups.

Information - Confirmation messages i.e.-login to chamber. Inactive Acknowledged (or 
no alarm) -IA

Alert - Unexpected conditions, not critical i.e.-chamber in database trying to login. 
Inactive Unacknowledged - IU

Error - More serious conditions, response needed i.e.-Error sending email alerts. Active 
Unacknowledged - AU

3.2 Chambers Panel
The “Chambers Panel” controls display of the chamber thumbnails in the Central ManagementTM 
Network. Select the grouping you want to display on the Chamber Status thumbnail Window,  
Figure 3.15: Chambers panel.

All the remaining categories are user defined. Icons indicate the current alarm status of each 
group. The meaning of each icon is shown in Alarm Icons above.

The letter abbreviations correspond to the Chamber Controllers designations.

Show all 
“Show all” displays all chambers active or not

Active alarms 
“Active alarms” shows only chambers with active alarms

User folders
The entries of the “Chambers Panel” below the black line are 
User added “Folders”, used to organize the Chambers in a 
logical manner that is appropriate to the User’s needs.
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3.3 Tools Menu

Diagnostics

DCS Test

This diagnostic tool can be used to verify the DCS (Dry Contact System) operation and to 
ensure the alarm contacts correctly signal the Autodialer or Central Monitoring Station, 
Figure 3.16: Diagnostics.

Send Test Email

Verify the email configuration is 
configured correctly by sending 
a test Email to any valid Email 
address. Setting for SMTP 
server and Email configuration 
must be completed in the 
“Setting” window prior 
to testing, Figure 3.16: 
Diagnostics.

Test Sanity Reset
Select Test Sanity Reset to be certain that the Watchdog 
Card is working properly. Sanity reset cannot be stopped 
once YES is selected, Figure 3.17: Sanity Warning. After a 
time delay of about 40 seconds the system is rebooted. The 
Central ManagementTM system will automatically restart and 
run the necessary services to monitor the Chambers.

If Sanity reset fails, refer to Chapter 6.0 System Maintenance 
and Troubleshooting for Sanity Card settings and 
troubleshooting hints

Settings
Select “Tools” then “Settings” to configure the Central 
ManagementTM options. See Chapter 6.0 System 
Maintenance and Troubleshooting for details on each 
setting, Figure 3.18: Application Settings.

Figure 3.16: Diagnostics

Figure 3.17: Sanity Warning

Figure 3.18: Application Settings
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The default settings for the Central 
ManagementTM system are documented 
in chapter 6.0 System Maintenance and 
Troubleshooting, however most settings never 
need to be altered. Email, Mail Server and Web 
Server setting have user site specific addresses 
that need to be provided by the on site IT 
administrator. Please refer them to Chapter 6.0 
System Maintenance and Troubleshooting, 
Figure 3.19: Settings Categories.

Network Subscribers
Network Subscribers are typically system 
administrators. All Chamber alarm 
conditions are sent to the Network 
Subscribers. Regular Subscribers are added 
to the individual “chamber property” 
Subscriber lists. Users appearing in both lists 
will receive only one email alarm notification, 
Figure 3.20: Network Subscribers.

Users can be added to the Network 
Subscribers list by clicking on the drop-down 
list box and selecting one or more of the 
displayed names. If this list is empty, you must 

first add users with the “Edit Users” selection 
of the Actions menu, Figure 3.21: Network 
Email Subscribers. 

Add as many users as needed.

Deleting an existing Network Subscriber is 
easily done by selecting the column preceding 
the name entry and pressing the delete key. 
This list can be empty.

Figure 3.19: Settings Categories

Figure 3.20: Network Subscribers

Figure 3.21: Network email subscribers
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CMP6000 Alarm Triggers
Select Tools, then “CMP6000 Alarm Triggers” to set 
the default actions for all CMP6000 series Chamber 
Controllers, Figure 3.22: CMP6000 Alarm Triggers.

Global settings
The default Alarm Triggers settings are the Global 
Alarm action rules applied to every CMP6000 Chamber 
Controller, Figure 3.24: Default Alarm Triggers.

Individual settings on a Chamber-by-Chamber basis can 
be set by a similar page in the Chambers 
properties menu of each Chamber 
Thumbnail display. See the following 
section for details.

Chamber settings

To change a specific Chamber’s Alarm 
actions; Find the Chamber to edit in 
the Central ManagementTM ’s Main 
Status display window and right-click on 
the Thumbnail display to bring up the 
Chamber menu. Select “Properties”, 
Figure 3.23: Chamber Properties.

Figure 3.22: CMP6000 Alarm Triggers

Figure 3.24: Default Alarm Triggers

Figure 3.23: Chamber Properties
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Then select the Alarm Tab. On an 
individual alarm, add or remove the 
check mark (P) to change the default 
actions for this chamber.

The settings shown in Figure 3.25: 
Chamber Alarm Settings, are the alarm 
action rules applied to Chamber 001 a 
CMP6000 Chamber Controller.

The settings that are grayed out are 
the Global defaults that are currently 
applied. Overriding a Default Alarm 
action will add a check mark the 
“Custom” box for the row associated 
with the setting you have altered.

Each setting can be enabled () or 
disabled (blank). “Reset to Defaults” 
will set this chamber to the “Default 
Alarm Triggers” settings. “Edit 
Defaults” will open the “Default Alarm Triggers” Global settings for you to make changes 
that will effect all chambers.

Clicking “OK”, will accept and activate the settings, “Cancel” will exit without saving changes.

3.4 File Menu

Figure 3.26: File 
Refresh

Refresh all
Clicking on, File “Refresh All” menu choice will force a Thumbnail 
display refresh, Figure 3.26: File Refresh.

Figure 3.27: Exit

Exit
Exit will close Central ManagementTM without further dialog, Figure 
3.27: Exit.

Figure 3.25: Chamber Alarm Settings
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3.5 Help Menu

Help

Selecting “Help” will open a PDF copy of the Central 
ManagementTM  Operators Manual, Figure 3.28: 
Help. The PDF file C:\Program Files\CM\Manuals\
CMOperatorsManual.pdf for 32 bit installations and C:\
Program Files (x86)\CM\Manuals\CMOperatorsManual.pdf 
for 64 bit installations file can be copied to another PC and 
used for reference. It is not printable.

About
Selecting “About” will show the technical and legal details of Central ManagementTM 
software, Figure 3.29a: About and 3.29b: Technical and License Details

3.6 Chamber menu Properties
Right-Click on a Chamber’s Thumbnail display, to 
open the Thumbnail menu. 

Select “Properties” to view the chamber’s 
information, Figure 3.30: Chamber Menu.

Figure 3.29b: Technical and License Details

Figure 3.29a: About

Figure 3.28: Help

Figure 3.30: Chamber Menu
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Information
Select the TAB for the category to view or modify. The Information tab is displayed by 
default. All chamber information entered by the “Edit Chambers” window is displayed 
for the selected chamber, Figure 3.31: Chamber Information. Legacy chamber Controllers 
(CMP4000 and CMP5000) will show the Alarms tab greyed-out, as this feature is exclusive to 
the CMP6000 Controllers.

Service history

The Service History shows the current operating history of control devices in the selected 
chamber. Each chamber’s list will be different, Figure 3.32: Service History. This tab will be 
greyed-out for the CMP6000 Controllers.

Figure 3.31: Chamber Information
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Items prefixed with “SP” are set-points and do not have a recorded history. Selecting “Refresh” will 
get the current values from the chamber. “Copy” will add the Service History onto the Windows 
clipboard for easy pasting into reports. Service History is also available in the Web Reports.

Service notes
Service Notes can contain any useful information, such as; Maintenance, Operations journal, 
problem log or part replacement schedules, Figure 3.33: Service Notes.

Figure 3.32: Service History

Figure 3.33: Service Notes
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Experiments
Experiments are more than records of chamber usage. They can document the User or any 
informative notes that are pertinent to the scheduled experiment. The start and stop dates 
assist the Manager to determine the duration of all experiments. The Scheduler can print 
reports by Chamber or by User, Figure 3.34: Experiment Schedule.

Subscribers
Click on the small black triangle to display the current user list. You can only add current Users to 
the subscriber list. To add new or edit users, see the “Edit User” topic, Figure 3.35: Subscribers.

Figure 3.34: Experiment Schedule

Figure 3.35: Subscribers
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Trend Graph
Right-Click on a Chamber’s Thumbnail display to open 
the Thumbnail menu. Select “Trend Graph” to plot the 
Chamber’s information, Figure 3.36: Chamber Menu.

Trend Graph will display up to 4 plots of logged data from 
a Chamber. Up to 365 days in sequence may be shown on 
one plot. Additionally Chamber Alarm impulses may be 
plotted on the graph, Figure 3.37: Trendgraph.

Legacy chambers may have a varied 
selection of logged data and logging 
frequency. That option is set at the 
Chamber “Options Screen”. Note 
that CMP6000 Controllers have a fixed 
logging frequency (18 seconds).

Full graph customizing and printing 
menus are available by selecting “Print” 
or “Customize”

Acknowledge alarms
Right-Click on the Thumbnail display 
of the alarming chamber, then select 
Acknowledge Alarms, Figure 3.38: 
Acknowledge Alarms.

Acknowledging alarms indicates to the 
system that you have “seen” the alarm condition and 
subsequent action is now your responsibility. Acknowledging 
stops the local audible alarm and email notification as well 
as changing the state of the chamber display icons of the 
System tray, Thumbnail display and Chambers panel. This 
is a chamber specific command that will only acknowledge 
alarms at the selected chamber.

See Chapter 4.0 Chamber Activities for details on 
responding to Alarms.

Figure 3.37: Trendgraph

Figure 3.38: Acknowledge Alarms

Figure 3.36: Chamber Menu
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3.7 File locations
Files are stored on the local hard drive in different locations 
since version 7.5 of the Central ManagementTM  systems. Both 
file locations are similar in structure and differ only in their 
“root” location, Figure 3.39: File Locations. With a Central 
ManagementTM  system the files are located as follows: (xxx is 
Chamber ID).

System files for application
- C:\Program Files (x86)\CM

Application activity log files
- C:\Program Files (x86)\CM\ActivityLogs

Application debugging* log files (* not active by default)
- C:\Program Files (x86)\CM\Applogs

Log and Alarm files via Central ManagementTM 
- C:\Program Files (x86)\CM\Chambers\xxx

Log, Alarm and Program Files via Virtual Chamber
- C:\Program Files (x86)\CM\Sites\Local network\xxx\Alarmlog
- C:\Program Files (x86)\CM\Sites\Local network\xxx\Datalog
- C:\Program Files (x86)\CM\Sites\Local network\xxx Programs

The current 64 bit Windows installation is shown. A 32 bit system uses a 
similar path , but without “(x86)

Under the Sites directory is the default site name “Local Network”. Central ManagementTM 
automatically creates (as needed) directories for Chamber Numbers, AlarmLog, DataLog and 
Programs. All files are text based and readable, with the exception of .CCF configuration + 
.CP4 program files. These are raw Controller Files. 

This page applies to the legacy CMP4000 and 5000 Controller based 
chambers. The CMP6000 based chambers save configuration files (xxxx.
CCF) by default to the “My Documents folder”. You can save files to that 
location or add them to the existing logical CM folder structure.

Figure 3.39: File Locations 

Do not edit “CP4” or “CCF” files!
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PGM files are readable and editable versions of the CP4 files. Log and Alarm files are not 
intentionally duplicated. If Virtual Chamber is used to download Log and Alarm files from the 
Flash drive of a Chamber (optional storage) these files are stored in:

CM\Sites\Local network\xxx\

The file data is the same, but the latter files are branded by Central ManagementTM, with 
received time and date, automatically storing logs in the default location:

CM\Chambers\xxx\

Virtual Chamber
Virtual Chamber is used to communicate with the Chamber’s Controller. Many user level 
functions can be performed from this interface remotely. 

Right-Click on the Chamber Thumbnail Display and 
Choose “Virtual Chamber”, Figure 3.40: Virtual Chamber.

Two distinctly different User interfaces are provided 
depending on the Controller type. CMP5000 and 
CMP4000 series Controllers use a “Virtual Chamber” 

interface, Figure 3.41: Virtual Chamber. 
The CMP6050 Controller uses the 
“Remote Control” interface, Figure 
3.42: Remote Control.

Both programs use the mouse and 
keyboard to make icon selections and 
input information. The program editors 
have “cut and paste” editing, file import 
and export. Refer to Chapter 4.0 Chamber 
Activities for detailed instructions.

Figure 3.41: Virtual Chamber

Figure 3.42:Remote Control

Figure 3.40: Chamber Menu
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4.0 CHAMBER ACTIVITIES
The Chamber Activities outlines the necessary day to day activities in a work flow format to 
aid the Administrator in using the software effectively.

In this chapter, you will learn how to

•	 Work with User Types and Security

•	 Setup Alarm Priorities, Procedures and Actions

•	 Plan with Experiment Scheduler

•	 Operate Remote Chamber software (Virtual Chamber and Remote Control)

4.1 User Types and Security Roles

Administrator
The Administrator has full access to the Central ManagementTM PC and can Edit Chamber 
Lists, Users, Experiments, responds to alarm conditions, update service logs and print 
chamber usage reports. They can work at the Central ManagementTM console or via Remote 
Desktop access. The Administrator typically receives global email alerts. Other users can be 
selected to receive global email alerts - there is no restriction on the number or type of user 
to be alerted. Two additional Security “levels” are provided - “Local” and “Remote”. The 
Windows and Chamber logon securities protect against unauthorized changes.

Local Network User
These Users may or may not have access to the Central ManagementTM PC as determined by 
the Administrator. From any network connected PC, they can use a Web Browser to connect 
to Central ManagementTM. From a Web Browser, Web Reports are presented showing a 
thumbnail display for all chambers. Users can download alarm and data files, view service 
history, receive email alarm alerts on a chamber-by-chamber basis. This requires low security, 
as no changes can be made - that is, it is a view-only mode.

Remote Users
Via the Internet, all or part of any of the above User Types can be enabled, as determined by 
the local IT security and firewall configuration rules.

Acknowledging, responding to and correcting alarm conditions can prevent 
more serious problems. Alarm priorities are set first in the chambers’ Alarms 
screen for CMP4000 and CMP5000 Controllers. Individual parameters can 
be given priorities in the range of 1-99. See the CMP5090 User Guide for 
details. Central ManagementTM software has an Alarm actions setting for 
each CMP6000 chamber to enable or disable the alarm actions for each alarm 
condition Reference: (Section 4.2 Alarm Actions)
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4.2 Alarm Actions
Central ManagementTM responds very specifically to three ranges of alarms for the CMP4000 
and CMP5000 chambers and three client selectable actions for the CMP6000 chambers.

Above Priority 40
No Central ManagementTM response, alarm message is displayed and logged.

Priority 31-40
Audible alarm from Central ManagementTM PC 

Priority 21-30
Email alert   +   Audible alarm

Priority 1-20
DCS alarm   +   Email alert   +   Audible alarm

Respond by using one of the Acknowledge Alarm buttons at the Central ManagementTM or on 
the Alarms Screen at the chamber. This will silence the alarm. Assess and correct the cause.

A thumbnail for a given chamber on the Central ManagementTM 
dashboard must be configured and active before the alarm can be 
received from that chamber.
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Tip: About Chamber Alarm Communication. Chamber alarm messages are sent to 
Central ManagementTM when they are initially added to the Chamber alarm list. Existing 
alarm state changes are not sent to Central ManagementTM. Deleting the alarm from the 
Chamber will ensure it is reported to Central ManagementTM if it becomes re-activated. 
Central ManagementTM has an “Alarm Delay” function implemented. The delay is 
the time (5 seconds) that an alarm must be present in the active state before the Dry 
Contacts System will be triggered. Version 7 of CCS added a “DCS Reset Interval”, 
which automatically resets the DCS after 10 seconds (default), permitting retriggering of 
the DCS for subsequent alarms.

4.3 Dry Contact System (DCS)
The DCS has two isolated sets of Form “C” dry 
contacts for alarm triggering to external systems. 
Typically these may be an Autodialer and/or a 
Building Monitoring System, Figure 4.2: DCS and 
Autodialer Operation.

DCS automatically resets after 10 
seconds (default), permitting 
retriggering of the DCS and 
Autodialer for subsequent alarms.

The Autodialer will respond to an alarm by dialing up to four 
separate telephone numbers. When the call is answered, 
an “Alert Condition” message is delivered and a user-
recordable voice message. The Dial out sequence can be 
“acknowledged” by sending “555” from the phone keypad 
during a received call. This ceases dial out.

 

 

Figure 4.2: DCS and Autodialer Operation
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Alarm States

Normal Operation Initialization code during startup of the Central ManagementTM 
program, causes relay on the DCS box to be energized. The green 
LED will be illuminated. This is the normal operating condition.

Alarm Condition A red LED illuminated and a de-energized relay signals an  
alarm condition.

Power Failure Alarm Should a power failure occur at the Central ManagementTM PC, the 
relay will de-energize and remain de-energized until the return of 
power and Central ManagementTM operating system startup.

Chamber Alarm Upon receipt of a chamber alarm of high priority (1-20) the Central 
ManagementTM will de-energize the relay.

Acknowledging the voice warning is not the same as acknowledging 
the alarm. Both Central ManagementTM and the autodialer must be 
acknowledged. Most important is the alarm at the chamber that caused the 
dial-out event. If you are on site, you can look at Central ManagementTM 
or chamber and diagnose what action needs to be taken to correct the 
problem. If you are remote, you have the option to connect to Central 
ManagementTM to view the alarm condition or use email alerting/web 
reports to view the actual chamber number and alarm condition. If the 
chamber must have the program settings altered, this can be done online 
using Central ManagementTM. In the absence of Central ManagementTM a 
hands-on visit to the chamber would be required.
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4.4 Acknowledging Alarms with DCS

Alarm sequence
Sequence of operation 1 During normal operation, when there are no active, 

unacknowledged alarms with a priority in the range of 1 to 20, 
on the network, the NORMAL (green) LED will be illuminated.

Alarm and delays 2 When an alarm occurs on any network chamber, the alarm 
delay is started. (5 second default.)

3 The audible alarm is triggered and the email alert is sent.

4 The alarm delay lapses and the triggering of the DCS box 
occurs. The alarm LED (red) on the dry contact box lights. It will 
remain on until either acknowledged or auto reset (10 seconds).

Autodialer 5 The autodialer input recognition delay starts (5 seconds 
default) and after the delay lapses, the autodialer will 
initiate calling the designated phone numbers (how many 
times it calls and how many numbers it calls depends on 
the programmed settings of the autodialer).

Acknowledge 6 When the call is answered, you can acknowledge the alarm 
warning by pressing the appropriate touch tone buttons) 
on the telephone (555 is default).

Reset 7 The “Reset DCS” button returns the dry contact box to its 
normal state. The alarm LED will turn off and the normal 
LED will turn on. If another high priority alarm occurs while 
you are diagnosing and fixing the present problem, the 
system will be ready to phone out again. If this crucial step 
is skipped, the autodialer cannot be triggered to call out 
for the subsequent alarms.

Diagnose 8 The next step is to diagnose the chamber that had the 
alarm and take the necessary steps to correct the fault.
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“DCS Reset interval” which automatically resets the DCS after 10 seconds 
(default), permits retriggering of the DCS and auto dialing systems for 
subsequent alarms. If set to 0, (default is 10 seconds) the DCS will not 
reset after an alarm, forcing a manual “reset DCS” to be made on Central 
ManagementTM’s Actions menu.

Sensaphone autodialer connected to older Central ManagementTM 
systems used a default “input recognition time” of 3 minutes. This is not 
compatible with Central ManagementTM default settings. The result will 
be an autodialer that is never activated by alarms. The recommendation is 
to reduce the “input recognition time” to 5 seconds. The reason for the 3 
minute “input recognition time” in earlier systems was to mask a Central 
ManagementTM sanity reset from alarming. While instability was an issue 
in Windows® operating systems prior to Windows XP®, this situation is very 
unlikely to occur with the current Central ManagementTM version.

4.5 Scheduling Activities

Chamber scheduler

Figure 4.3: Chamber Scheduler Toolbar

Save
Save is required when changes are made. If you do not save, when you exit, changes will be lost.

Show Since
“Show Since” places the center of your scheduler view at the date you selected from the 
drop down calendar.

Time Scale
“Select View” then “Time Scale”. The default time scale settings are shown. Both the 
bottom and middle tiers may be altered to show a time scale that suits your needs. 

Group By
The Default View shows Chamber ID, Figure 4.4: Default View. To change the grouping, 
select “View” then “Group By” then select a new item category from the “group items by” 
list. Click OK to update your scheduler display.
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Tip: Editing Chamber and Users are explained in Chapter 3.0 Using Central Management™.

Views

Two different views of the chamber information are available to the administrator to use.

Time Line View

More than one experiment may be “attached” to a Chamber as shown above by Chamber 
001. The list of Experiments may be “rolled up” to show only a single line per Chamber, 
Figure 4.5: Time Line View.

Figure 4.5: Timeline view

 
Tip: The Schedule “Time Line” changes color to a darker shade as time progresses. The red 
line indicates the current date.

Figure 4.4: Default View Figure 4.4a: User View
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Grid view

The Grid View permits easy experiment schedule view reordering by selecting any of the 
column headers, such as User or Start Date, Figure 4.6: Grid Line View.

Figure 4.6: Grid Line View

New experiment  

A “New Experiment” allows the administrator to plan every aspect of the chamber’s usage.

Figure: 4.7: Experiment Info

Chamber, User, Start and End dates are mandatory. However, additional information such as Name 
and Notes will assist with administration tasks, Figure 4.7: Experiment Info. Experiment information 
appears on each Chambers’ properties menu as a “Tab”, Figure 4.8: Chamber Information.

The experiment name is displayed on the Chamber Scheduler main window and helps 
differentiate one experiment from another. By default, lists are sorted by Chamber ID, but 
may be resorted by any of the displayed fields.
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Three Notes areas are provided for each Chamber. The Experiment Notes are expected 
to be used for experiment related information (guidelines and warnings), Chamber notes 
(equipment specifications) and service notes for chamber maintenance.

Right-Click on any Chamber’s Thumbnail display to open the Thumbnail menu. Select “Properties” 
to view the Chamber and Experiment information, Figure 4.8: Chamber Information.

Figure 4.8: Chamber Information

Reports 

Select “Reports” from chamber scheduler menu, Figure 4.3: Chamber Scheduler Toolbar

Select the date period for the usage report, Figure 4.9: Usage Reports

Figure 4.9: Usage Reports

Select the button for either “Report by user” or” Report by Chamber”, Figure 4.10: By User 
and Figure 4.11: By Chamber. Print or Copy to Clipboard as needed.

Figure 4.10 By user Figure 4.11: By chamber
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4.6 Using Virtual Chamber - CMP4000-5000 Legacy

Start a Virtual Session
Different interfaces are displayed, depending on the 
type of Chamber control System you have selected 
to program. The following information, Sections 4.6 
to 4.11 refer to the CMP4000 and CMP5000 series 
Controllers. For details regarding the CMP6000, refer 
to 4.12 Using Remote Control CMP6000. (Central 
ManagementTM uses the appropriate interface, 
according to chamber configuration – Section 2.6 
Adding a chamber to the status display).

From the Central ManagementTM dashboard, choose the chamber number to connect to and 
“right click” on the chamber thumbnail, selecting “Virtual Chamber”, Figure 4.12: Chamber 
Menu - Virtual Chamber.

Figure 4.13: Virtual Chamber Display

Active Controller
Touchscreen Area

Chamber Information 
Status Bar

Virtual Chamber
Toolbar

Figure 4.12: Chamber Menu - Virtual Chamber
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Could Not Connect

This error message indicates a complete communications failure. Check all settings and 
connections and retry. If the problem persists, refer to Chapter 6 System Maintenance and 
Troubleshooting or seek Conviron Technical assistance.

Figure 4.14: Could Not Connect

Time-out

The inactivity time-out period (15 minutes) has expired and Virtual Chamber has automatically 
disconnected from the Chamber. This ensures that the Chamber will be available for local 
Touch-Screen login.

Figure 4.15: Disconnected
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4.7 Virtual Chamber Functions

Figure 4.16: Virtual Chamber Toolbar

open print copy help
sort 
rows

sync 
time

edit 
program

virtual 
chamber

view log 
files

load current 
program

new save cut paste

Toolbar

New Ctrl+N Clears the spreadsheet.

Open Imports program (pgm) from disk.

Save Ctrl + S Saves current program to chamber.

Print Prints current program or chamber screens.

Cut Ctrl+X Cuts contents of selected cells (s).

Copy Ctrl+C Copies contents of selected cells(s).

Paste Ctrl+V Pastes clipboard contents to selected cells(s).

Sort Arranges rows (time lines) in chronological order.

Load Loads the current program into the chamber editor (ready to run)

Sync Synchronizes chamber date and time to Central ManagementTM

VC Panel View virtual chamber screens of logged in chamber

Program editor Edit chamber programs on Virtual Chamber program editor

Log files Download and view alarm and data of files from chamber storage drive

Help Opens the Help Document VC3.pdf
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Menus

Figure 4.17: File Menu

File
Same functions as the Toolbar icon, plus; 

Save as 	 Permits saving the loaded program to a  
different number

Export 	 Exports program (pgm) to Program disk

Logon  	 Allows entering the required security 
information when   Chamber Security is enabled.

Figure 4.18: Edit Menu

Edit
Same functions as the Toolbar icon, plus;

Undo	 Ctrl+Z  Undoes the last operation

Delete Rows	 Deletes the selected row

Select All	 Ctrl+A Selects all the cells of the spreadsheet

Insert Row 	 Ctrl+I Inserts a blank row at selected location

Figure 4.19: Tools Menu

Tools
Same functions as the Toolbar icon, plus;

Upgrade 	 For upgrading the software of the Controller. 
Conviron is the sole provider of software and 
can add new functions to existing Controllers.

Send File 	 Factory-only software feature.

Retrieve File	 Factory-only software feature.
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Help
This icon will open the Virtual Chamber Manual in PDF format. All User Manuals 
are located in the default installation directory; 

C:\Program Files (x86)\CM\Manuals

4.8 Chamber Panel

Figure 4.20: Virtual Chamber

Trendgraph

Security Diagnostics

Options

Alarm

Program

Help

See the CMP4030 or CMP5090 User Guide for full details about Controller software 
functioning and use. All the expected chamber Controller features are available at Central 
ManagementTM, using a mouse click rather than a screen touch.
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4.9 Program Editor

Selecting the “Program Button” starts the program editor, Figure 4.22: Program Editor.

With Central ManagementTM, you can write a program, store it on the Central ManagementTM 
system, and download it to any chamber Controller on the network.

In this section you will learn to:

•	 Understand the name and function of each section of the Program Editor

•	 Write programs using the Program Editor

•	 Print a program from the Program Editor

•	 Load programs onto a chamber Controller from the Program Editor

•	 Save programs onto chamber Controller from the Program Editor

•	 Import and Export a program into the Program Editor from Central ManagementTM

Figure 4.21: Program Editor

2 4
1 3 6 5

7
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Parts of the Program Editor

1.	Name list 
The name list lists the programs stored on the chamber Controller. The name of the 
program currently loaded into the Program Editor is displayed.

2.	Chain list 
The chain list lists the programs stored on the chamber Controller. The program name 
displayed is the program to which the program currently loaded into the Program 
Editor is chained.

3.	Column 
The column field tells you the zone currently selected in the table.

4.	Units 
The Units field tells you the units of measurement used by the current zone.  i.e.: °C for 
temperature

5.	User Limits 
The User Limits (Active Zone Operating Range) field tells you the Chamber operating 
range for the active zone. 

6.	Factory Limits 
The Factory Limits (Active Zone Alarm Limit Range) field tells you the range of setting 
for the Alarm Limits that apply to the active zone. You cannot change factory settings.

7.	Program table 
The program table or spreadsheet is a series of columns and rows in which you enter  
your program.

Using the Program Editor

Clearing the program table 
To clear the program table to start writing a new 
program, from the “File Menu”, choose New.

Or Click the      icon on the Virtual Chamber 
Toolbar, or Press CTRL+N. If there are values in the 
table that have not been saved, you are asked if you want to save changes. Click “Yes” to 
save changes or “No” to lose changes. The program table is cleared.

Figure 4.22: New Program
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Entering Values 
To enter a value into the program table select a cell and type a value.

Deleting Values from Cells 
To clear a value from a cell or series of cells, select the cell 
or range of cells that you want to clear. From the Edit menu, 
choose Cut.

Or select the  icon or Press CTRL+X. The selected cells are cleared and the values are 
copied to the Windows clipboard.

Copying values in cells 
To copy a cell or range of cells. Select the cell or range of cells 
that you want to copy. From the Edit menu, choose Copy

Or Click the  icon, or, Press CTRL+C. The values of the cells 
you selected are copied to the Windows clipboard.

Pasting values into cells 
To paste values that you have cut or copied to 
new cells select the cell to which you want to paste values. If 
you are pasting a range of cells, select the first (top, left) cell in 
the range.

From the Edit menu, choose “Paste”, or click the  icon, or, Press CTRL+V.

The last value that was cut or copied is pasted to the selected cell or cells.

Selecting the whole table 
You can select the entire program table, copy it, and 
append it to another program.

To select the whole program table, from the Edit menu, 
choose “Select All”, or  
 
press CTRL+A, the whole program table  
is selected.

Figure 4.23: Delete 

Figure 4.24: Copy

Figure 4.25: Paste

Figure 4.26: Select All



June 2011 | Revision 2.44-18

CHAPTER 4.0 | CHAMBER ACTIVITIES

Inserting a row 
To insert a row into the program table, select a cell in the row 
above where you want to insert a row.

From the Edit menu, choose “Insert Row”, or 
 
press CTRL+I, a blank row is inserted after the row  
you selected.

Deleting a row 
To delete an entire row select a cell in the row that you want  
to delete.

From the Edit menu, choose Delete Row(s).

The entire row is deleted and the following rows are moved up in the table.

Sorting rows 
To sort rows by time:

From the Edit menu, choose “Sort”, or

click  the icon. The program rows  
are sorted chronologically.

Undo edit 
To Undo an Edit operation and restore the cell(s) to prior values:

From the Edit menu, choose “Undo”, or

press CTRL+Z. The value(s) are restored to the affected cell(s)

Saving a program to a chamber Controller 
After writing or editing a program in the Program 
Editor, it must be named before saving. Also, you 
must save it on the chamber Controller before you 
can load and run it.

To save an already named program (just edited): 

From the File menu, choose “Save”, or

click the  icon, or press CTRL+S. The Program 
is saved immediately.

Figure 4.27: Insert Row

Figure 4.28: Delete Rows

Figure 4.29: Sort Rows

Figure 4.30: Undo

Figure 4.31: Save To Chamber
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To save an unnamed program (newly created): 

From the “File” menu, choose “Save As”, Figure 4.32: Save to Chamber, or 

click the  icon.

The “Save As” dialog box appears.

Type a program number in the text box that is numeric only and is a maximum of eight 
characters. Select the “OK” button. The program is saved on the chamber Controller with 
the numeric name just assigned.

Saving a Program on Central ManagementTM 
To save a program written in the Program Editor on 
Central ManagementTM:

From the “File” menu, choose “Export Program”, 
Figure 4.32: Export Program.

Next the “Export Program” dialog box appears. In 
the File Name text box, type a name, up to eight 
characters, Figure 4.33: Export Program Dialog.

Or, 

If you want to save the program with an existing file 
name, select the name you want from the File 
Name list.

If you want to save your file in a different 
directory or drive, select a new path from 
the Directories and Drives lists.

Select OK,

The program is saved in Central 
Management™. Programs stored in Central 
ManagementTM have a file extension of ‘pgm’ 
and are text based. They can be opened and 
edited with Excel or text editors.

Figure 4.32: Export Program

Figure 4.33: Export Program Dialog
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Loading a Program to the Chamber Controller’s Program screen

Before you can run a chamber program, you must load the program into the chamber 
Controller’s Program screen. You cannot run a chamber program from the Program Editor. To 
load a program, make sure that you have saved the program on the Controller as described 
in the previous section.

From the File menu, choose Load Current Program 
to Chamber, or

click the  icon.

The program is loaded to the Controller’s Program 
screen. Go to the Chamber panel, then Program 
Spreadsheet to Run the program.

Opening a program saved on the Central 
ManagementTM system
To open a program saved on the Central ManagementTM system:

From the “File Menu”, select “Import Program”, Figure 4.35: 
Import Program.

Next the “Import Program” dialog box appears, Figure 
4.37: Import Program Dialog. From the file name list, select 
the file that you want to open. If you do not see the file you 
want, select a new directory or drive from the directories and 
drives lists.

Programs stored on the Central 
ManagementTM system have a file  
extension program.

Find your file, select it and click “Open”.

The program you selected appears in the 
Program Editor

Figure 4.34: Load To Chamber

Figure 4.35: Import Program

Figure 4.36: Import Program Dialog
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4.10 Printing a program
To print a copy of the program currently loaded into the Program Editor:

From the File menu, choose Print, or

click the  icon.

The Central ManagementTM system prints the 
Program Editor table.

4.11 Log Files

If the chamber is equipped with additional log storage, Virtual Chamber can access, 
download and view both Alarm and Data logs. The Virtual Chamber status bar shows if a 
storage drive is installed on a Chamber, Figure 4.38: Chamber  
Status Bar.

Figure 4.38: Chamber Status Bar

To access the Log Files on the Controller, select the  Button on the Virtual 
Chamber Toolbar.

Figure 4.37: Print Program

Floppy Storage or Flash Card
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Sync

Files must be downloaded from the chamber Controller to work with them. This is called 
sync.

Select the number of days to SYNC data from the chamber to Central ManagementTM from 
the Synch Files List Box, Figure 4.39: Select Sync Duration.

Figure 4.39: Select Sync Duration

Click on the  Button and Virtual Chamber will retrieve the files from the chamber 
Controller. If a file doesn’t exist, nothing will be downloaded.

Figure 4.40: Sync File Progress

A progress indicator and file listing shows the file downloading progress, Figure 4.40: Sync 
File Progress.
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File Locations
Central ManagementTM stores the files retrieved by Virtual Chamber on the local hard drive under

C:\Program Files (x86)\CM/Sites

Under the Sites directories is the default site name “Local Network” 

Under the “Local Network” Virtual Chamber automatically creates (as needed) directories for 
Chamber Numbers, AlarmLog, DataLog and Programs. All files are text-based and readable, 
with the exception of .CP4 program files. These are raw Controller files and PGM files are the 
readable versions. 

Do Not Edit CP4 Files!

Figure: 4.41: File Locations

CMService Logs

Virtual Chamber Logs
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View
Once the log files are retrieved, selecting a file name in the left pane will display its contents 
in the right pane, Figure 4.43: Log File View. The data view can be scrolled, sorted and 
copied. If a selected file shows no data on the right pane, it is likely that the storage media is 
full and should be cleared.

Figure 4.42: Log File View 
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4.12 Software Upgrades for CMP4000 and CMP5000
Conviron can offer software upgrades to Chamber Controller software to enhance the 
operation of the Chamber, add new features and change the mode of the alarming functions. 
Contact Client Services for details.

Floppy vs. Flash vs. Hard Drive
Depending on the physical characteristics, age and versions of the hardware and software, 
the features of the CMP Controllers vary. Conviron maintains detailed information that is 
easily accessed by the chamber serial number. The current features as well as the upgrade 
abilities can be determined by providing this information in any upgrade request.

Prepare Package
Conviron will provide the upgrade software package 
either on Floppy disk, Flash Card or via electronically 
transferred zip file (email or the Conviron FTP site). 
For installation by Central ManagementTM or Virtual 
Chamber, the best practice would be to unzip and copy 
the update package to the local hard drive. Logically 
if you are to upgrade Chamber 3, place the update 
package in a directory within Chamber 3’s file structure, 
Figure 4.43: Chamber Directory.

Logon
With a Central ManagementTM system, select the chamber 
number to connect to and right-click on the chamber 
thumbnail, selecting “Virtual Chamber”, from the 
“Chamber Menu” Figure 4.44: Virtual Chamber Login.

Figure: 4.43: Chamber Directory

Figure 4.44: Virtual Chamber Login
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Security
A minimum Security Level 40 is required for the “Software Upgrade” feature. This protects 
the chamber Controller from accidental corruption by unauthorized personnel. After logging 
on to the chamber, from the “Chamber Menu”, select “Login” from the “File Menu”. 

Type a user name and password that have security level 40. 

Contact your administrator or Conviron for access information, Figure 4.45: Security Dialog.

Figure 4.45: Security Dialog

Locate Upgrade

The next step is to select Upgrade from the Tools Menu, Figure 4.46: Tools-Upgrade. The 
upgrade dialog box will open, Figure 4.47: Upgrade Dialog. Select “Browse”, and navigate 
the directories to:
C:\Program Files (x86)\CM\Chambers\003\Update

Figure 4.47: Upgrade Dialog

Figure: 4.46:Tools-Upgrade
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Serial Number
All Conviron products are identified by serial number and upgrades must be for the matching 
serial number! 

Figure 4.48: Upgrade Dialog Serial Match

 If you see the “DO NOT MATCH” message, do not continue. CANCEL the 
operation and contact Conviron Client Services for assistance.

Figure 4.49: Upgrade progress

Once the Serial Numbers are confirmed to match, select “Upgrade”. The upgrade file transfer 
dialog will show the progress of the update procedure.
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Reboot
After all files have been transferred to the chamber Controller, a “Reboot?” dialog will 
display. The chamber Controller must be restarted for changes to take effect. Select “Yes”.

Additionally, power to the chamber Controller needs to be cycled off, then on again after  
10 seconds.

Figure 4.50: Upgrade Complete

The Controller should restart and in a minute or two, show the status screen. If this does not 
occur as expected, repeat the power cycling and follow the recommended startup procedure 
for CMP Controllers as outlined in the CMP4030 – CMP5090 User Guide or Conviron 
CMP4030 Version 6.00 - 6.20 Software Update Guide.

4.13 Using Remote Control - CMP6050

Introduction
The CMP6050 is the most advanced control system developed by Conviron. Configured to 
your chamber specifications from the factory, the CMP6050 offers a wide array of set-up, 
control and alarm features to tune the configuration to your specific requirements. As well, 
the scalability of the CMP6050 accommodates additional Input/Output ports should your 
research require additional sensors.

Users of Central Management™ must be aware that changes they make will 
impact electrical and/or mechanical operations of a chamber(s) at a location 
that they are not visually monitoring and/or physically present at. 

Operating the chamber remotely, while others are occupying or servicing the 
chamber, COULD BE HAZARDOUS AND MAY RESULT IN PERSONAL INJURY 
to service or other on-site personnel.  As such, manipulation of parameters 
via CM must only be performed when Users have taken appropriate safety 
precautions including having established that NO ONE ELSE is occupying or 
servicing the chamber while using CM software.
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Remote Control Operations

The Remote Control Main Menu shows all of the software features, Figure 4.51: Remote 
Control Main Menu. 

Figure 4.51: Remote Control Main Menu

Remote Control allows the User to:

•	 Connect to your chamber

•	 Download (save) or Upload (retrieve) chamber configuration

•	 Start and Stop a chamber schedule

•	 Create / Edit / Delete Programs and Schedules

•	 Perform Time Synchronization

•	 Modify Chamber Ramp and Step Operation

Chamber Communication
Addressing

TCP/IP

All Chamber settings are done in the CMP6050  Options screen.

SNMP

Port 161 is the standard SNMP port. This port is not alterable.

Remote Access
Firewall

Windows™ or third party firewall software must allow the SNMP port (161) to pass through 
from the Chamber to the Central ManagementTM and / or Remote Control software.
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Chamber Information	

When connected to a Chamber, the Chamber information is displayed in the Remote 
Control’s status bar.

Connection status, Chamber serial number, Controller version and remote Control software 
version are displayed. Access to the CMP6050 Controller is via Central ManagementTM.

Connecting to Chambers
Connection to a chamber is normally done by right-clicking on the chamber Thumbnail of the 
Central ManagementTM status window and choosing Virtual Chamber from the menu. 

Once you are connected to a chamber the Remote Control main menu will appear onscreen, 
Figure 4.52: Remote Control Main Menu.

Figure 4.52: Remote Control Main Menu

 During a Remote Control session, the Chamber Touch screen is locked from 
local use. This ensures that only one user at a time has access to a Chamber.

Disconnect
Click on the “exit”  Icon to terminate an active connection. Should you forget that 
you are connected to a Chamber, the Remote Control software will detect inactivity and 
self-terminate after 15 minutes. The Chamber Controller will be released from Touchscreen 
lockout a few seconds after Remote Control is stopped.
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Configuration Files
Configuration files are the complete set of Chamber Programs and schedule information that 
the Chamber requires to operate.

Upload

Click on the “Upload” Icon. Upload prompts you to chose previously saved 
configuration files from the local PC to send to the connected Chamber.

Download

Click on the “Download” Icon. Download retrieves configuration files from the 
connected Chamber and saves them to the local PC. The default save directory is 
“My Documents”, which can be altered.

Chamber Status
Starting and Stopping

Once you have connected to a chamber the “Status” of the schedule (and Chamber) can be 
observed by noting the state of the “Start” and “Stop” icons. 

When the Chamber is running the “Stop” icon is illuminated.

When the Chamber is stopped the “Start” icon is illuminated. 

When the “Start” icon is selected, you are prompted to pick a program 
to run from the Schedule.

Programming
Creating a program

Select the CREATE icon to start the program creation procedure. The next unused 
program number will become available. 



June 2011 | Revision 2.44-32

CHAPTER 4.0 | CHAMBER ACTIVITIES

Click SELECT to accept or use the spinner to choose another number. Only unused program 
IDs will be displayed, Figure 4.53: Program Selector.

Figure 4.53: Program Selector

The Program Spreadsheet will be activated. Use the Program Spreadsheet Tools to Insert 
timelines specific to your needs. A step by step procedure to edit a program follows in 
section “Editing a Program”.

Figure 4.54: Program Spreadsheet

Program Spreadsheet Tools

Insert Line Inserts a time line with default settings.
Duplicate Line Inserts a copy of an existing line to speed program creation. 
Delete Line Removes selected line or lines from the program.
Sort Lines Selecting column header arranges lines in ascending or descending 

order within the selected column.
Graph Highlight one or more columns, by selecting the column header with a 

right-mouse click. Select Graph to view data graphically.
Delete Program Not active unless the Delete Program icon was selected to open the 

Program Editor.
Upload Program Saves the new or edited program to the chamber Controller.
Close Quits Program and unsaved changes are lost.
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Figure 4.55: Program Verification

Editing a program

1.	 Select the Edit  icon to start the program editing procedure.

2.	 Click Select to accept or use the spinner to choose another number. Only used 
program IDs will be displayed.

3.	 The Program Spreadsheet toolbar will be activated.

4.	 Insert Line – Inserts a time line with default settings.

5.	 Sort Lines – Selecting column header arranges lines in ascending or descending order 
according to the selected column.

6.	 Graph – Programmed parameters can be easily verified by highlighting one or more 
columns by a right-mouse click. The column header will change color to indicate 
selection.  Select to view data graphically.
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7.	 Upload Program - Select this button to save the current Spreadsheet program to the 
chamber. Select “Close” to quit and lose program or unsaved changes.

8.	 The final step to Run the program requires adding it to a Schedule. Refer to section 
Creating / Editing a Schedule for complete details.

Deleting a Program
The Program Spreadsheet toolbar will be activated, Figure 4.54: Program Spreadsheet.

Delete Program 	 Deletes the currently selected program.

Close 	 Quits Program and unsaved changes are lost.

Scheduling

Creating/Editing/Deleting a Schedule

•	 Creating a schedule is only allowed if there is no existing schedule. 
The Delete button is disabled. Once the schedule is created the 
Delete icon is enabled.

•	 Editing a schedule requires an existing schedule.

•	 Deleting a schedule is only allowed if there is an existing schedule. 
The Create button is disabled. Once the schedule is Deleted the 
Create icon is enabled.

Schedule Table Tools

Insert Entry Add a line to the schedule table. Entries of program number and 
program repeats are defaulted to “1”. Edit as needed.

Delete Entry Removes a program from the schedule table.
Program repeat May be set  between 1 and 99 repetitions of the program.
Global repeat May be set between 1 and 99 or infinite / continuous repetitions of 

the schedule.
∞ Select the infinity symbol to set the Global Repeat to continuous.
Upload Schedule Sends the schedule to the chamber.
Close Quits Schedule and unsaved changes are lost.
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Working with the Schedule Editor

Select Create Edit or Delete Schedule.

Selecting one of the Schedule icons opens the Schedule Editor, Figure 4.56: Schedule Editor.

Both Create and Editing a schedule follow the same procedure;

Figure 4.56: Schedule Editor

1.	 Open the schedule editor.

2.	 Add or modify schedule entries for 
programs and repetitions.

3.	 Set global repeat.

4.	 Upload schedule, it must be uploaded to 
the chamber to be saved.

5.	 Closing will exit without saving changes. 

6.	 To run the schedule, select the start icon and 
then select the program (row) to be the first 
program to run.

Figure 4.56a: Start Chamber

Figure 4.56b: Start Schedule
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Time Synchronization

Select the Time Synchronization icon to set the Controller to the same time and 
date as Central ManagementTM.

Figure 4.56c: Time Synchronization

 Altering the Controller time and date will cause changes to the logged data.

Ramp-Step Mode Setting (Prior to version 3.10)

Previous versions of the CMP6050 software allowed Step or Ramp Mode control 
for temperature, and Step Mode only for all other processes.

•	Select the Ramp/Step icon to open the Ramp/Step Setting dialog, Figure 4.57a: 
Ramp/Step Settings. The Ramp/Step Disable Dialog will open. 

•	 Selecting “Step” grays out the speed setting. 

•	 The permissible setting range is from 4 to 900 
minutes per degree Celsius. Attempting to set 
beyond this range will cause a warning dialog to 
be displayed.

•	 Select ‘Save’ to save the settings and immediately 
update the chamber controller or close to quit 
without changes.

•	 When the mode is changed, the chamber will 
confirm the setting with the dialog of Figure 4.58 
Change Mode.

Figure 4.57a: Ramp/Step Settings 
Software versions prior to v3.10
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Revised Process Ramping (for version 3.10)

The CMP6050 controller with controller software version 3.10, will allow selection between Step 
Mode, Ramp Mode, or Disable Mode for all process controls. The various modes can be changed 
while a program is running. Note that all 
processes can be disabled, except temperature.

•	 Select Ramp/Step or Disabled for any of 
the processes of the dialog.

•	 Select OK to save the settings and 
immediately update the chamber controller 
or close to quit without changes.

•	 When the mode is changed, the chamber 
will confirm the setting with the dialog of 
Figure 4.58 Change Mode.

Security and Login

The security settings are entirely based in the Chamber Controller. This permits individual 
Chamber by Chamber settings.

Security and Log-In Screen

A single prompt for password will appear if the security features are enabled at the Chamber 
Controller. The password entered is validated by the chamber and access is granted if the 
password matches the Chamber settings.

Log-Out Security Screen

Logout is automatic. When the Remote Control program is terminated, you will be logged 
out of the Chamber in a few seconds.

Figure 4.57b: Ramp/Step Setting
Software v3.10 and later

Figure 4.58: Change Mode
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5.0 REMOTE CHAMBER PROGRAMMING
The Remote Chamber Programming allows the user to work with the Chamber from offsite 
locations using remote communication technologies.

In this chapter, you will learn how to:

•	 Add Subscribers

•	 Receive and use Email Alerts

•	 Use WebReports to view Chamber history

•	 Connect to Central ManagementTM via Remote Desktop

5.1 Email Alerts
This section covers the Email Alert message and its features. The configuration details of 
the Central ManagementTM Email settings are covered in Chapter 6.0 System Maintenance 
and Troubleshooting.

All of the features in this Chapter require configuration by on site IT personnel.

Alert Subscriber
There are two types of Subscribers for Email Alerts.

•	 Network Subscriber; receives Global Email Alerts from all chambers on the Network

•	 Chamber Subscriber; receives Email Alerts only for the chambers for which he has 
subscribed, Figure 5.1: User Creation.

Figure 5.1: User Creation 
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All Subscribers must first be added as Users via Central ManagementTM “Edit Users” menu 
item. Name and valid email address are required. Once in the User List, Names can be 
“attached” to a particular chamber subscriber list or added to the network subscribers list. 

Add subscribers
To Add a Chamber Subscriber to a particular 
chamber, start by right-clicking on the particular 
chamber thumbnail of Central ManagementTM. This 
opens the Chamber Menu, Figure 5.2: Chamber 
Menu - Properties.

Next, select “Properties”.

Select the “Subscriber” tab of the Properties window. 

Figure 5.3: Chamber Subscriber 

Click on the drop-down menu  q  to 
display the current user list, Figure 5.3: 
Chamber Subscriber.

You may add one or more users to the 
subscriber list. All users will receive an 
Email Alert when an alarm condition at 
this chamber is triggered that meets the 
Email Alert configuration.

To Add a Network Subscriber to Global Email Alerts, from Central ManagementTM select 
“Tools” menu and then “Network Subscribers”, Figure 5.4: Network Subscriber.

Again, you may add one or more Network Subscribers to the subscriber list. All subscribers 
on the list will receive an Email Alert in the event of an alarm condition at ANY Network 
Chamber that meets the configured Email Alert settings. Subscribers who are listed on both 
Network and Chamber lists will receive only a single Email Alert.

Figure 5.2: Chamber Menu – Properties
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Alert Message

The Alarm email message contains; 

•	 when the alarm occurred

•	 what the priority was and

•	 a text description of the  
alarm condition

The Chamber uses abbreviations 
in the description, that are easily 
understood. Looking at the 
description line of the sample 
Alert Message in Figure 5.5: Alert 
Email Message: “Description: High 
Humidity”, selecting the Web Report 
link opens a Web page, Figure 5.7: 
Email Alert Link Page, with in depth 
information on alarming chamber.

Figure 5.4:Network Subscriber 

Figure 5.5: Alert Email Message 

Web Report Link

Alarm Description
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5.2 Web Reports

Status

Figure 5.6: Web Report 

Setpoint

Actual

Name

Alarm Status
Chamber ID

Thumbnail Status Displays

Folder panel

Network 
 Status
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Chamber Page
Selecting a chamber ID number will link to the Chamber page. The current alarm status messages 
are displayed. Five menu choices allow navigation to additional information pages. Each page 
allows for the selection of particular time periods for the displayed data, Figure 5.7: Email Alert 
Link Page.

Alarm History
After clicking on Alarm History, specify the date to display and click “Show”, Figure 5.8: Alarm History.

Figure 5.7:Email Alert Link Page 

Figure 5.8: Alarm History 
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Log History
After clicking on Data Log History, specify the date to display, check “Show Alarms” if 
desired, and click “Show”, Figure 5.9: Log History.

Trend Graph

After clicking on Trend Graph, specify the date and number of days to display. Select the 
data fields to graph from the list boxes and click “Show”, Figure 5.10: Trendgraph. Optionally 
check “Show Alarms” to display alarm time indicators.

Figure 5.10: Trendgraph 

Figure 5.9: Log History 
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Service History
After clicking on Service History, 
the current time-on or cycles of 
each output will be shown. These 
values can only be changed at the 
Chamber’s local display screen and 
only for CMP4000-5000, Figure 5.11: 
Service History.

Download Data
To download Chamber logged 
information (alarm or data logs), 
Select the Chamber, Start and End 
dates, then the type of data, Alarm 
or Log data. Finally click on extract, 
Figure 5.12: Download Data.

The “Download Data” form 
automatically suggests a suitable 
name for the data downloaded, 
Figure 5.13: Open / Save Download.

Figure 5.11: Service History 

Figure 5.12: Download Data Figure 5.13: Open/Save Download
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5.3 Remote Desktop

This instruction is based on Microsoft Windows XP Professional. Other 
Windows interfaces differ slightly.

Conviron Central Management™ is normally the connection point to several 
external alarm monitoring systems. Consequently, it is important to understand 
the following;

1. Users of CM must have permission to connect to CM and if the work 
requires rebooting or shutting down the equipment, the onsite authority 
must be informed such that this procedure can be accomplished safely.

2. Be certain of the correct procedures for remote connection, login and 
disconnect. It is possible to select the incorrect “quit” methodology and 
“shutdown” the CM system rather than simply disconnecting the remote 
connection. If the system is shutdown, all subsequent chamber alarms 
occurring would not be recognized by CM, thereby failing to send out 
alarm notifications.  Once shutdown, the CM system would require a 
manual startup. 

3. While the CM system shows many of the chambers’ parameters, alarm 
settings and physical conditions are not available to the remote user. Any 
type of change or diagnostics are best performed when onsite personnel 
are available to work with the remote user.

Central ManagementTM access is via generic Windows Terminal Services or Microsoft 
Windows Mobile 2003SE for PDAs.

Logon Security
By default, Conviron supplied Central ManagementTM systems have the Remote Desktop 
connection enabled. Typically only the administration account “conviron” is permitted to 
“take-over” control of the Central ManagementTM computer.

Install Defaults
The login and password is unique for each 
Central ManagementTM system and is 
documented in the Central ManagementTM 
Installation Manual delivered with the product 
shipment. If this information is lost, please 
contact Conviron Client Services, with your 
Central ManagementTM serial number, which is 
located on the Central Management™ PC side 
panel, Figure 5.14: Serial Card.

Figure 5.14: Serial Card
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Single User
Microsoft Remote Desktop protocol (3389) can be used to do a Central ManagementTM 
takeover.  Microsoft XP Professional software allows a single logon session at any given 
moment. When the remote desktop session is active, the Central ManagementTM console 
cannot be used without disconnecting the remote user. Conversely, locally logging on to the 
Central ManagementTM system during a remote session will disconnect the remote user.

When a user is disconnected, their programs are closed and unsaved data 
may be lost.

Start
To connect to the Conviron Central 
ManagementTM Server, open your Remote 
Desktop program:

Start > All Programs >  
Accessories > Communications >  
Remote Desktop Connection

Type in the TCPIP address of the Conviron 
Central ManagementTM Server, using the 
address that your on site IT staff provide, 
Figure 5.15: Remote Desktop - Connection.

This will likely be the 
TCPIP address of a 
firewall or the Central 
ManagementTM system 
Building Network 
Connection address.

Click on the OPTIONS 
button to set the defaults 
for your sessions.

Options

Before connecting, review the Settings under each Tab to set the desired parameters for 
your connection and graphics needs. To share drives and clipboard with the remote Central 
Management™ system, the related options must be enabled, Figure 5.16: Remote Desktop Options.

Figure 5.15: Remote Desktop - Connection

Figure 5.16: Remote Desktop - Options
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Display
The display setting shown is the default. This is suitable for most situations, Figure 5.17: 
Remote Desktop - Display Settings.

Figure 5.17: Remote Desktop - Display Settings

Local Resources
Clicking on the “more button” shows the drive 
list, Figure 5.18: Remote Desktop - Sound and 
Drive Mapping. 

Checking a drive letter enables disk drives to 
be available to transfer local files to and from 
programs on Central ManagementTM Server. 
Improved performance will be achieved if 
these options are disabled. Checking printers 
allows your local attached printer to be 
available on Central ManagementTM  server 
programs. Printer driver installation may be 
required, depending on printer requirements. 
Ensure Clipboard is checked to allow cut 
and paste operations between the Central 
Management system and remote computer.

Figure 5.18: Remote Desktop - Sound and Drive Mapping
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Experience
Set the performance option of the experience tab 
to your connection speed. Un-checking the features 
boxes will speed the display performance but lower 
the quality of the Central ManagementTM  screens, 
Figure 5.19: Remote Desktop - Experience.

Save defaults
Once these are set as needed, return to the 
General Tab and save your settings for future 
connections, Figure 5.20: Remote Desktop -Save 
Setting - Connect.

Select “Connect” to start the logon process. This 
required you to have an active Internet connection.

Logging On
As soon as the connection is established, a dialog 
box will prompt you for User name: and Password:

As noted earlier, contact Conviron Client Services if you 
have lost this information. Be prepared to provide the 
Central ManagementTM  system serial number.

Once you are connected, the Central ManagementTM 

Desktop will be displayed in Full-screen. 

When your session is complete, Select “Log Off” 
to close programs and close the remote session. 
The Central ManagementTM  programs run as 
Windows Services and will run as long as the 
Central ManagementTM  Computer is powered on.

Figure 5.19: Remote Desktop - Experience

Figure 5.20: Remote Desktop - Save 
Settings - Connect
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6.0 SYSTEM MAINTENANCE AND TROUBLESHOOTING

The Central ManagementTM  system settings, Chamber configuration, Operating System and 
the Client PC settings are all important to ensure systems communicate properly.

In this chapter, you will learn how to:

•	 Connect Hardware Components

•	 Check all system settings - Central ManagementTM , 
Firewall, Chamber

•	 Test functionality of devices

•	 Perform Basic Troubleshooting

•	 Configure Software features

•	 Setup Central ManagementTM  Backup

•	 Run DVD Restore System

•	 Update DVD Restore

•	 Install Central ManagementTM  Software-only

6.1 Connection Procedure
1.	 Connect the Cabling to the Chamber

2.	 Connect Devices to the Network Switch

3.	 Connect Central ManagementTM 

4.	 Set the TCP/IP Addressing of Central ManagementTM  

5.	 Set the Chamber ID (TCPIP) Addressing

6.	 Verify and Test Communications

Follow the connection procedure, ensuring all devices are connected before 
applying power.

Figure 6.1: Ethernet Connections
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Cable
Ethernet Straight-through cables 
are normally connected to the 
network Switch (or Hub) and to 
each device.

If no switch is involved, an Ethernet 
Crossover cable is connected directly 
from the Chamber to the PC.

See Figure 6.2: Ethernet Crossover 
Cable diagram for details.

Chamber
1.	 Connecting the Cabling to the Chamber 

The Central ManagementTM  network uses 
UTP (Unshielded Twisted Pair) 100Base-T 
Category 5E, Ethernet cabling. From the 
Chamber the cable exits the control panel 
and is laid in a series of “J” hooks crossing 
the ceiling/wall. The “J” hooks are spaced 
on a maximum of 5-foot centers and bring 
each cable run in an organized fashion 
from the devices (Chamber and PC) to 
the Switch(es) location, Figure 6.3: J Hook 
Cable Supports. 
 
Connections to the 
Chamber Controller should 
be made with the Controller 
powered off. 
 
Connect an Ethernet 
cable to the Chamber. 
The cable is connected to 
an RJ-45 receptacle on the 
bottom plate of the chamber 
Controller or at the top of 
the Control Panel. See Figure 
6.4: CMP4000-5000 Ethernet 
Connection point or Figure 6.5: CMP6000 Ethernet Socket.

Figure 6.2: Ethernet Crossover cable

Figure 6.3: J-Hook Cable Supports

Figure 6.4: CMP4000-5000 Bottom Ethernet Connection

Figure 6.5: CMP6000 Ethernet Socket
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Switch

2.	 Connecting to the Network Switch 
The switches or hubs provide multiple ports that are 
wired with Ethernet UTP cables connecting each 
chamber to Central ManagementTM . Each port has the 
same function. One cable for each device, Figure 6.6: 
Network Switch.

PC
3.	 Connecting the PC (Central ManagementTM ) 

Connect the Chamber and Central ManagementTM  PC 
to the Ethernet switch using the same ethernet cabling 
as the Chamber. The correct network adapter to connect 
to the chambers is labeled “Chamber network”, Figure 
6.7: Central ManagementTM  PC Connections. 
 
The Building Network connection is optional and must 
be configured by on site IT staff.

4.	 Checking the Addressing of the Central 
ManagementTM . The Central ManagementTM  system 
is installed with 192.168.0.100 (netmask 255.255.255.0) 
as the default network address. Chambers also default 
to 192.168.x.xx for Central ManagementTM  Network, 
but their address must be set, so each chamber has a 
unique ID (address). 
 
Assuming the first chamber is set to 192.168.0.1 (Unit 
ID 001) set each chamber to have sequential IDs. 
(1,2,3 ...and so on). Conviron has reserved the first 
(100) addresses for legacy chambers, CMP4000 and 
CMP5000. The remaining addresses of 192.168.0.101 
to 254 are suitable for selection for CMP6050 chamber Controllers. 
 
The standard configuration of the chamber Controllers prior to CCS v7 used different 
TCP/IP addresses. New chambers use 192.168.x.xx by default. Legacy chamber 
configurations MUST be updated to enable communication to the new Central 
ManagementTM  address.

 Updates must be done with the assistance of Conviron Client Services

Figure 6.7: Central ManagementTM       
PC Connections

Figure 6.6: Network Switch
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Chamber address
5a.	 Setting Addresses CMP4000 and CMP5000

•	 Power up the Chamber’s Controller. 
Once you see the chamber status 
screen, touch  
 
the Options  icon and 
locate the Group and Unit numbers.

•	 Touch the group and unit buttons, 
Figure 6.9: Address - Group + Unit to 
set the Controller’s Group to “0” and 
Unit ID to “1-99” or the desired TCP/IP 
address.:

•	 Once the Group and Unit are  
set, ‘Touch’ 
 
the “EXIT”  icon, to save 
 the change and exit.

•	 A pop-up window will appear warning “Net 
Address changed you must cycle power”. 
Proceed to ‘Select’ OK. After the restart the 
new Unit ID will be shown on the Controller 
status display, Figure: 6.8: CMP5090 Status 
Display.

•	 When the Status screen is viewed, communication between the Chamber and Central 
ManagementTM  should be completely functional.

 Addressing format requirements:

IP address is 192.168.x.yy 
x is the first digit of the LCS. Range is 0 to 9 
yy are the last two digits of the ID. Range is 1 to 99 
Subnet mask is fixed at 255.255.255.0

Setting the Unit ID to 001 will set the TCP/IP address of the chamber to 
192.168.0.1.
Remember, the chamber must be set to an address in the same network (x) as 
the Central ManagementTM  PC (default - 192.168.0.100).

Figure 6.8:  CMP5090 Status Display

Figure 6.9: Address - Group + Unit
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Chamber address

5b.	Setting Addresses CMP6000 
The CMP6050 series can be connected to a Central ManagementTM  system on an 
Ethernet Local Area Network. To enable communications the Controller must be 
connected to the network and configured with a suitable network address. There are 
two network addresses to set up in the CMP6050 series as follows:

•	 CMP Address:	 Address or ID of the Controller within the network.

•	 Netmask:	 Divides an IP address into subnets and specifies the network’s  
	 available host.

•	 Central Management™	 Enables or Disables CM communication

•	 CM Address	 Central ManagementTM  IP Address

A valid IP address is needed for the CM Address value even if there is no 
Central ManagementTM  system present.

To set the Chamber Addressing:

a.	 From the status screen, touch the ‘ID’ button  to access the network 
configuration, Figure 6.10: Network Configuration)

Figure 6.10: Network Configuration

Up

Enter

Down

Figure 6.10a: Controller Keys

  If “Disabled” is displayed, Select the “Disabled” text and use the “Scroll Up” 
arrow key to change “Disabled” to “Enabled”, then press “Enter” to save. 
(Figure 6.10a: Controller Keys)
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b.	 To change the address numbers touch each individual 
numerical field. A pop-up keypad, Figure 6.11: Keypad will 
appear each time a field is accessed. 

c.	 Once all the addresses have been entered, touch the 
‘EXIT’ button, Figure 6.12: Exit and a pop-up warning 
window, Figure 6.13: Save Changes, will appear to confirm 
the numerical entries: 

d.	 Touch the ‘Yes’ or ‘No’ button to return to the Status 
Screen. Touch the ‘Cancel’ button to return and re-
enter any numerical address errors.

Figure 6.11: Keypad 

Figure 6.13: Save Changes 

Figure 6.12: Exit
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Test
6.	 Test Communications with Central ManagementTM  

 
When the chamber Controller boots up it senses the cable connection to the switch 
and to Central ManagementTM  system. If the connections are in place and configured 
correctly, the Controller signals Central ManagementTM  and a socket connection 
(software communication) is established. Through this socket, the chamber information is 
sent to Central ManagementTM . The most obvious indicator of the communication is the 
Chamber Status Thumbnail on Central Management. To start Central ManagementTM , 
double-click on the Central ManagementTM    icon. 
 
If the unit ID for your chamber is not shown on the “All Chambers” display, you 
must select “Edit Chambers” to add a new display. “Grayed-out” displays are not 
communicating between Central ManagementTM  and the Chamber., Figure 6.14: 
Central ManagementTM  Status Thumbnails. 
Chamber thumbnail displays will appear, typically, when a chamber is powered on. 

After a PC power on, thumbnail displays may take up to 15 minutes to appear. To verify 
communications to the chamber, a virtual login can be attempted at any time. Just 
right-click on a thumbnail display and select ”Virtual Chamber” from the “Chamber 
Menu”, Figure 6.14a: Chamber Menu.

Figure 6.14: Central Management Status Thumbnails 

Figure 6.14a: Chamber Menu
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This window, Figure 6.15: Connecting, may appear as 
communications initiate with the chamber. Normally this 
proceeds rapidly. Within seconds the Virtual Login will 
open to the chamber status screen, 

One of the following Virtual Chamber Status screens will 
appear indicating the connection is successful, Figure 
6.16: Virtual Chamber for CMP5090 or Figure 6.17: Remote 
Control for CMP6050. If neither appear, an error message 
will be displayed.

The error messages indicate a communications failure, Figure 6.18: Login Failure - CMP5090 
and, Figure 6.19: Login Failure - CMP6050. Use the Chapter 6.2 Diagnostics section that 
follows to check all settings and connections and then retest. If the problem persists, seek 
Conviron Technical assistance.

Figure 6.15: Connecting 

Figure 6.16: Virtual Chamber for CMP5090 

Figure 6.17: Virtual Chamber for CMP6050

Figure 6.18: Login Failure - CMP5090 

Figure 6.19: Login Failure - CMP6050
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6.2 DiagnosticsSwitch
The Switch has indicators that will assist in 
determining if connections and communications 
are operational, Figure 6.20, Network Switch.

 Link/Act -This indicator lights up when the 
port is connected to an Ethernet device; if the 
light is blinking, it indicates that data is being 
transmitted or received.

Power - The Power indicator lights green when 
the switch is receiving power; otherwise, it is off. 

FDX / Col (Full-duplex/Collision) - This LED 
indicator lights green when a respective port is 
in full duplex (FDX) operation mode. Otherwise, 
it is blinking when collisions are occurring on the 
respective port in half duplex operation mode.

100Mbps - This LED indicator lights green when 
the port is connected to a 100Mbps Fast Ethernet 
station. Otherwise, the LED is off when the port is 
connected to a 10Mbps Ethernet device. 

Figure 6.20: Network Switch 

 

The Link light must be illuminated for 
any device connected to the switch, 
when the devices (Controller or PC) are 
powered on. 

If not, check the device connected to 
that port. Reasons may include: 

•	 The cable may  
be disconnected

•	 The cable may be defective

•	 The device address may be 
unset or

•	 It may need a reboot

 

If, when the Chamber Controller is 
powered on and the green Ethernet 
Network Indicator is OFF, check the 
following;

•	 Cable is connected

•	 Address is set

•	 Reboot Controller

•	 Software problem reload

•	 Hardware problem  
replace Controller
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Chamber
On the rear panel of the Chamber Controller 
are several indicators for diagnostics. The 
green Ethernet Network Link Indicator 
must be constantly illuminated for Network 
communications to be functional. The red Ethernet 
Activity Indicator will flash intermittently when 
information is being transferred. (Such as during 
the PING test), Figure 6.21.

Central ManagementTM

Link/Activity –  Figure 6.22: PC 
Ethernet Connector shows a 
steady green indicating good 
link between the Network Card 
and the switch. Flashing green 
indicates activity (transmitting or 
receiving) within the adapter.

Full– Steady green indicates the 
adapter is operating in full- 
duplex mode.

1000M – The LED indicator lights green when a 
1000 Mbps device is connected to the adapter.

100M –The LED indicator lights green when a 100 
Mbps device is connected to the adapter.

If all the above checks were accomplished and still 
no Thumbnail Display activity is seen. 

•	 Try a Virtual Login to the Chamber

•	 In a Command window run a Ping Test. See the 
Ping section that follows for complete details. 

 For hardware problems with PCs that are under Conviron warranty, contact 
Conviron Client Services. For software issues, re-installation of a device, driver or 
program will correct most problems. The Central ManagementTM  system can be 
restored to factory conditions using the Restore feature as a final solution.

Figure 6.22: 
PC Ethernet 
Connector 

Figure 6.21: CMP5090 Indicator LEDs

If, when the CM is powered on, and 
the green Ethernet Network Indicator 
is OFF, check the following

•	 Cable is connected

•	 Address is set

•	 NIC is Enabled

•	 Software problem Run “ping 
127.0.0.1” you must get a reply, 
not a time-out or error.

•	 Hardware problem replace NIC
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Network Ping
The Ping utility is essentially a system administrator’s tool that is used to see if a computer is 
operating and also to see if network connections are intact.

A small packet is sent through the network to a particular IP address. 

The computer that sent the packet then waits (or ‘listens’) for a return packet.

If the connections are good and the target computer is up, a good return packet will be received.

PING can also tell the user the amount of time it takes for a packet to make the complete trip.

One address that cannot be used by any computer in the world, is the address 127.0.0.1. This 
address has been reserved for what is known as the loopback address. A loopback address is 
an address that tells the computer to test its own basic network setup.

 All Conviron units by default use the prefix “192.168” (custom or versions prior 
to V7, may have a different default prefix).

How to test Network Connection using Ping
1.	 Open a “Command Prompt” window and at the prompt ( C:\ ), type the command line 

as shown, using the Unit ID number of the Controller as the internet address. Note, 
that all Conviron chambers use the prefix “192.168”

2.	 Use Ctrl-C to stop, record minimum, maximum and average ping times.

Usage: ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS]  [-r count] [-s count] [[-j host-list] | [-k 
host-list]] [-w timeout] destination-list

Example: 	 To test chamber 001 use: ping 192.168.0.1

	 To test chamber 101 use: ping 192.168.0.101
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Table 6.1 Ping Command Options

Usage: ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS]  [-r count] [-s count] [[-j host-list] | [-k 
host-list]] [-w timeout] destination-list

Options: Description:

-t Ping the specified host until stopped.

 To see statistics and continue - type Control-Break;

 To stop - type Control-C.

-a Resolve addresses to hostnames.

-n count Number of echo requests to send.

-l size Send buffer size.

-f Set do not Fragment flag in packet.

-i TTL Time To Live.

-v TOS Type Of Service.

-r count Record route for count hops.

-s count Timestamp for count hops.

-j host-list Loose source route along host-list.

-k host-list Strict source route along host-list.

-w timeout Timeout in milliseconds to wait for each reply.

If the basic communication problem persists, consult local IT staff or call 
Conviron Client Services for technical assistance.

6.3 Central Management™ and Chamber Networking
In all Windows based Computer Operating Systems a network adapter will require a TCP/
IP address to operate on the LAN. Conviron Software expects at least one adapter in the 
PC and it must be dedicated to the Central ManagementTM  Network. The address of the 
adapter must be known by the Conviron Central ManagementTM  software and  the chamber. 
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Both programs have settings that must agree with the Operating Systems TCP/IP setting. 
The Central ManagementTM  Setting “LCSNetwork” and the chamber setting of “Unit ID” 
must have the compatible TCP/IP settings as the Network Card allocated to the Central 
ManagementTM  Chamber Network.

See the following section for details of the software setting for Conviron applications.

6.4 Central ManagementTM Software Settings

Central ManagementTM Settings Panel
Select “Tools” then “Settings” to configure Central ManagementTM  options, Figure 6.24:  
Tools - Settings.

Figure 6.24: Tools - Settings

Figure 6.23: Internet Protocol TCPIP Settings
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Alarms
The Central ManagementTM  settings Panel has six sections for configuration information;

•	 Alarms

•	 DCS

•	 Debug Logging

•	 Email

•	 Server

•	 SMTP Mail Sever

•	 AlarmDelay setting will delay the alarm activation of email, audible and Dry Contact 
System alarms. It is specified in seconds, with a settable range of 1-999

•	 AudibleAlarmPriority setting will enable a short tone every 10 seconds for an 
Unacknowledged alarm that is less than or equal to the Audible Alarm Priority setting. 
The alarm priority setting for each chambers’ specific alarm condition is set in the Local 
Control System or Chamber’s Controller.

Figure 6.25: Alarms Settings

•	 DCSAlarmPriority (Dry Contact System) enables the Dry Contact System box to trigger 
contacts at the set priority value or less. Any Local Control System alarm of the priority 1 
to 20 inclusive will trigger the contacts.

•	 EmailAlarmPriority setting enables the alarm priority number which is compared to every 
chamber alarm. If the Alarms priority numbers is less than or equal to this setting, Central 
ManagementTM  will send an Email Alert notification action to all designated users. 

•	 ThumbnailDropDelay time (in seconds) will delay the triggering of a “communication 
lost” alarm, when a Local Control System disconnects from Central ManagementTM. This 
setting exists to provide compatibility with previous versions of Local Control System 
software that dropped connections intermittently, causing nuisance alarms. If set to zero 
this function is disabled.

•	 ThumbnailDropPriority setting is the alarm priority number applied to the “loss of 
communication alarm”, between the Local Control System and Central ManagementTM . 
The priority setting will determine Central ManagementTM ’s notification action. 
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Dry Contact System
•	 AudibleAlarm setting is true to be enabled and false to be disabled. The Audible 

alarm will emit a short tone every 10 seconds for an Unacknowledged alarm that is 
less than or equal to the Audible Alarm Priority setting. The alarm priority setting 
for each chamber specific alarm condition is set in the Local Control System or 
Chamber’s Controller.

•	 DCSAddress (Dry Contacts System) address is set by the factory to the value 
needed by the alarm-sanity card.  To obtain the address, with your mouse, right-
click on the Computer icon (MyComputer in XP) and Select “Mangage” from the 
menu. The Computer Management program will be displayed. Select “Device 
Manager” from the left column, double-click on “Data Acquisition” and then 
double-click on “ACCES PCI-WDG-CSM”. Select the “Resources” tab and note 
the first four characters of the second I/O range setting Figure 6.26a: Alarm Card 
Address. ( i.e.- E480 ) This address will be entered into the Central Management™ 
“Settings” dialog after the software installation. This address is inserted into the 
Central Management™ Settings “DCSAddress”. Figure 6.26: Alarm - DSC Settings.

Figure 6.26: Alarm - DCS Settings

Figure 6.26a: Alarm Card Address
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•	 DCSResetInterval a delay in seconds that the Central ManagementTM  System 
will wait before resetting the Dry Contact System contacts after an Alarm has 
occurred. Set to zero (0) to specify no interval.

•	 EnableSanityReset is set to “TRUE” (default) to ensure continuous operation of 
Central ManagementTM . In the event of PC lockup, due to a transient malfunction, 
the PC will be forced to restart.

Debug Logging
•	 DebugLogging should be set to 

“FALSE” (off) unless Conviron 
Client Services request this to be 
set on. When activated, detailed 
debugging log files are generated.

Email
•	 EmailFromAddress This is the 

email address that Central 
ManagementTM  will use on the 
Email Alert Message, it can be 
different from the SmtpUserID.

•	 EmailMaxAttempts is the 
maximum number of attempts the 
Central ManagementTM  System 
will try to send an email alert.

•	 EmailRetryDelay is the time 
in seconds that the Central 
ManagementTM  system will 
wait before trying to re-send an 
email if the SMTP server was not 
available. Range is 0 to 99999

Figure 6.27: Debug Logging

Figure 6.28: Email Local Settings
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Server
•	 LCSNetwork Class B TCPIP address. 

This must be the first two octets 
of the Central ManagementTM  
Network. Ex. ‘192.168’ For 
CMP5090 Controllers or earlier or 
the first three octets for CMP6XXX 
Controllers. Ex. ‘10.242.56.’

•	 PublicVirtualChamberPort defines 
the port that Virtual Chamber 
software uses to communicate to 
the Chamber.

•	 PublicWebAddress will appear in the email Alerts that Central ManagementTM  
sends to the Email Subscribers. Users may browse to this address to view the 
chamber status. The address is specific to each installation, as it typically reflects the 
Building Network Address. The Central ManagementTM  system is shipped with the 
Central ManagementTM  address with the above default setting, and the on site IT 
staff are responsible for providing the correct “Building Network” address.

•	 PublicWebPort is appended to the Public Web address to permit access via a 
Web browser to the Web Reports page. ex.  http://192.168.0.100:9001/?list

SMTP Mail Server

•	 SmtpAuthentication set this option 
to “TRUE” if your SMTP server 
requires authentication.

•	 SmtpMailServer is the address 
of your email server for Central 
ManagementTM  to send Email  
Alert messages.

•	 SmtpPassword is required if 
authentication is set “TRUE”

•	 SmtpUserID and password is 
assumed by your IT department 
will assign a SMTP User ID and 
password in conjunction with 
the Mail Server information. Once the server settings are complete and the 
“EmailFromAddress” is set, email alerts will be enabled. The final task would be 
to assign “Users” with email addresses to the “Network Subscriber List” or on 
individual Chambers’ properties forms. 

Figure 6.29: Server Settings

Figure 6.30: Mail Server Settings
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Restart the Conviron CM Service to accept all Email and SMTP Server settings.

6.5 Web Reports

Enable Web Reports
Follow this procedure to connect the Central ManagementTM  Building adapter to the 
Network, Intranet or Internet to provide Web Reports to the target audience.

•	 Open Network Connections and select the Building Network Adapter.
•	 Right-Click on the icon and select “properties” from the menu. 
•	 Select Internet Protocol version 4 and Click on “properties”.
•	 Note the IP address
•	 Insert this address in the Server Settings “PublicWebAddress”,  see Figure 6.29

Figure 6.31: Network Connections

Contact your IT department and have them assign a static TCPIP address for the Building 
Network adapter.

If external (Internet) access is to be provided, a default gateway and DNS server addresses 
may be required, Figure 6.32: Building Network.

All settings are site specific and the responsibility of the on site IT administration 
to provide.
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6.6 Virtual Chamber Settings

Central ManagementTM Client
Virtual Chamber, as part of the Central ManagementTM  software package, uses the settings of 
the Central ManagementTM  for locating the chambers by address. When you right-click on a 
thumbnail display and select Virtual Chamber, the Central ManagementTM  passes the network 
address and chamber number to Virtual Chamber. No additional configuration is possible.

Figure 6.32: Building Network
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6.7 Firewall Settings

Default Central ManagementTM Settings

Table 6.1: Microsoft Firewall Settings

Name Profile Enabled Action Programs
\ProgramFiles (x86)\CM\

Local  & Remote 
Address

Protocol Local 
Port

Remote 
Port

Central Management™ All Yes Allow CentralManagement.exe Any TCP Any Any

CM Service All Yes Allow CMService.exe Any TCP Any Any

CM Web Reports All Yes Allow Any Browser Any TCP 9001 Any

Remote Control All Yes Allow RemoteControl.exe Any TCP 161 Any

Virtual Chamber All Yes Allow VC.exe Any TCP Any Any

Remote Desktop All Yes Allow System Any TCP 3389 Any

Firewall settings are shown as a reference, Table 6.1: Windows Firewall Settings. Windows 
Firewall is enabled (by default) on the Conviron Central ManagementTM system.

Other security related programs will control the applications and external ports that 
are allowed to communicate with the outside world. This is normal behavior, however, 
these programs must have either permit rules or exceptions so you can authorize your 
communications program to use these ports to communicate.

Settings similar to those set for the firewall will enable Central ManagementTM programs to 
communicate via the Intranet and also the Internet. At the Enterprise Firewall the port 9001 
must be forwarded to the Central ManagementTM system, to allow remote Internet users to 
be able to view the Web Reports (port 9001).

Microsoft Remote Desktop protocol (3389) can be used to do a Central ManagementTM 
takeover and is recommended to be restricted to users with Administration level access. 
Microsoft software allows a single logon session at any given moment. When the remote 
desktop session is active, the Central ManagementTM console cannot be used, without 
disconnecting the remote user. Conversely, locally logging on to the Central ManagementTM 
system during a remote session will disconnect the remote user.
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Third party Client Security Software

The following programs were identified to require attention to ensure Central ManagementTM 
and the alerting mechanisms are operating correctly  
and completely.

•	 McAfee Antivirus and Intrusion Prevention

•	 Trend Micro Antivirus and AntiSpyware

This is not an exclusive list, certainly other Security programs will require similar rules or 
exceptions to be added for Central ManagementTM’s operation.

Add rules to “ALLOW” the programs in Table 6.2: Central ManagementTM Applications, to 
have unrestricted access the Central Control System Network. If Internet communications is 
utilized, then allow full Internet access, incoming and outgoing.

Table 6.2: Central ManagementTM Applications,

CentralManagement.exe Remote Control.exe

CMService.exe VC.exe

For Email, Virtual Chamber and WebReports access via the internet to be enabled, the following 
ports will need to be opened through any Firewall software;

Table 6.3: Central ManagementTM Port  Requirements

SMTP (port 25) - Email SNMP (port 161)

HTTP (port 9001) - Web Reports port 9002 - VC Routing

Please call your on site I.T. support before altering any security software settings.
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6.8 Central ManagementTM Backup

Central ManagementTM Software-only

The “software only” installation provides the optional backup scripts that are provided with 
Conviron’s Central Management™’s full hardware system.  

The required files for the automated backup system are provided in the C:\Program Files 
(x86)\CM\Util directory. These files need to be imported into the Windows 7 task scheduler:

CM2SSD_AutomaticBackup.xml and Backup CM Data to D partition.xml

It is up to the User to ensure the appropriate hardware is in place and to then activate the 
Tasks and test the backup system.

Central ManagementTM Hardware

The Central ManagementTM application uses Windows Task Scheduler and Windows Backup 
to automatically enable backup tasks for hardware based installations only.

Task Scheduler

The task “Backup CM Data to D partition.xml“ is used to run a command script (CMv81bak2D.
bat ) twice per hour to “backup” the application log files from C:\Program Files (x86)\CM 
directory and all the CHAMBERS and SITES subdirectories contents, to the D drive partition.

Once per hour the D drive directory CMbak is backed-up by the task “CM2SSD_
AutomaticBackup.xml “ to the Conviron Restore Drive (Solid State Drive H:). 

The Conviron command scripts can be modified to suit any special requirements. These files 
ASSUME a hardware setup of a C and D partition of the hard drive and a Conviron Restore 
Drive installed. Windows Backup™ software copies only the updated files from the D:\
CMbak directory.
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Backup Scripts

@echo off
rem Copyright 2011 Controlled Environments Limited, All Rights Reserved.bmc
rem CMv81bak2D.bat
rem V1.6  1/31/2011
echo %date%_%time%_Backup V81 to D drive started >> “C:\Program Files (x86)\CM\
ActivityLogs\backup.log”
xcopy “C:\Program Files (x86)\CM\Chambers\*.*” D:\CMbak\Chambers\ /E /D /C /K /Y
xcopy “C:\Program Files (x86)\CM\Sites\*.*” D:\CMbak\Sites\ /E /D /C /K /Y
xcopy “C:\Program Files (x86)\CM\ActivityLogs\*.log” D:\CMbak\ActivityLogs\ /C /K /Y
xcopy “C:\Program Files (x86)\CM\AppLogs\*.log” D:\CMbak\AppLogs\ /C /K /Y
xcopy “C:\Program Files (x86)\CM\*.license” D:\CMbak\ /C /K /Y
xcopy “C:\Program Files (x86)\CM\*.mdb” D:\CMbak\ /C /K /Y
xcopy “C:\Program Files (x86)\CM\*.config” D:\CMbak\ /C /K /Y
xcopy “C:\Program Files (x86)\CM\*.xml” D:\CMbak\ /C /K /Y
xcopy “C:\Program Files (x86)\CM\Chambers.txt” D:\CMbak\ /C /K /Y
echo %date%_%time%_Backup V81 to D drive completed >> “C:\Program Files (x86)\
CM\ActivityLogs\backup.log”
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Xcopy Command Syntax
Copies files and directory trees and is used in the backup scripts to quickly update the 
backups. This command tool may be modified to the clients needs.

XCOPY source [destination] [/A | /M] [/D[:date]] [/P] [/S [/E]] [/W]  [/C] [/I] [/Q] [/F] [/L] [/H] [/R] 
[/T] [/U] [/K] [/N]

Options Description
source Specifies the file(s) to copy.
destination Specifies the location and/or name of new files.
/A Copies files with the archive attribute set, doesn’t change the attribute.
/M Copies files with the archive attribute set, turns off the archive attribute.
/D:date Copies files changed on or after the specified date.  If no date is given, 

copies only those files whose source time is newer than the destination time.
/P Prompts you before creating each destination file.
/S Copies directories and subdirectories except empty ones.
/E Copies directories and subdirectories, including empty ones. Same as /S 

/E. May be used to modify /T.
/W Prompts you to press a key before copying.
/C Continues copying even if errors occur.
/I If destination does not exist and copying more than one file, assumes that 

destination must be a directory.
/Q Does not display file names while copying.
/F Displays full source and destination file names while copying.
/L Displays files that would be copied.
/H Copies hidden and system files also.
/R Overwrites read-only files.
/T Creates directory structure, but does not copy files. Does not include empty 

directories or subdirectories. /T /E include empty directories and subdirectories.
/U Updates the files that already exist in destination.
/K Copies attributes. Normal Xcopy will reset read-only attributes.
/Y Overwrites existing files without prompting.
/-Y Prompts you before overwriting existing files.
/N Copy using the generated short names.
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6.9 Conviron Restore Process

Overview

All software is preloaded into the PC. The information below is required for 
emergency re-installation only!

Software Restore Overview

The First step in the process to restore the Central ManagementTM system is to restart 
the CM system and boot into the Restore Drive. 

The Second step is select the System Image restore and choose the image from the 
Conviron Restore drive.

The Final step is to reload your personal applications added to Central 
ManagementTM after original delivery. Example Anti-Virus program.

Backup all critical data BEFORE using the Restore Process, as C:\ drive will be 
erased. All changes to the Central ManagementTM PC since initial startup will 
be lost. Chamber data is stored in the C:\Program Files (x86)\CM\Chambers 
directory. It is recommended to save all files in the “CM” directory with the file 
extensions of LOG, XML, MDB, PGM, ALE, CP4, LICENSE and TXT. By default, 
the Autobackup application has saved all the chamber data to the D: drive 
(partition) and H: Conviron Restore drive (Solid State Drive).

Only drive C:\ is affected by the restore process!

Software Restore Procedure
1.	 Select the start menu->shutdown->restart. As soon 

as the system’s beep is heard, tap the F8 key a 
couple times slowly.This will start the Boot Menu. 
If you miss the timing to start the boot menu, wait 
until the system has fully started, then”Restart” the 
again and repeat the process. 

2.	 Select the KINGSTON SV100S264G drive. This is the 
Conviron Restore Drive. Wait until the system starts.
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3.	 At the System Recovery Options dialog “Select Keyboard ...” leave “US” hightlighted 
and Select “Next”.

4.	 At the System Recovery Options dialog “Windows found problems...” Select “No”. Do 
Not Select “Repair and Restart”.

5.	 At the next System Recovery Options dialog Select “Restore your computer using a 
system image . . .” and Select “Next”.

6.	 At the System Recovery Options dialog “Select a System Image Backup”, Select “Use 
the latest available system image”, Location must be “Conviron Restore” drive then 
Select “Next”.

7.	 When the software re-installation is complete the computer will be restarted. The 
chambers will automatically logon within a period of about ten minutes or less. 

8.	 Once the system has been restored, copy backup data from either ”D:\CMbak” 
or “Conviron Restore Drive\CMbak” (Auto backup) backups to the Central 
ManagementTM installation location on C drive. This procedure will bring your system’s 
data from the factory settings up to the date of your last backup.

9.	 Lastly reload your personal applications added to Central ManagementTM after original 
delivery. Example Anti-Virus program.

Call 1-800-363-6451 or +1-204-786-6451 for Conviron Technical Services, if 
assistance is required

6.10 Creating a New System Restore Image

It is recommended to replace the restore image after major changes, such as  
application installation.

Step 1 Follow the Microsoft Backup instructions to make a “System Image” of C drive 
(including the system partition which is the default setting).

Step 2 Save this “system image” to a DVD or external drive and store it away safely 
for future use.

You may replace the “factory system image” on the Conviron Restore 
Drive, but do this at your own risk. Once it has been replaced you have 
only your current image for recovery options.
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6.11 About Information
To find the Central ManagementTM version number;

•	 From the “Help” menu, choose “About”.

The About Central ManagementTM dialog box appears. The version numbers are in the top 
half of the box, Figure 6.33: About Central ManagementTM.

To find the Central ManagementTM serial number

•	 Look on the side of the PC for a Card similar to 
Figure 6.34: Serial Number.

Figure 6.34: Serial Number

Figure 6.33: About Central ManagementTM

Version number
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7.0 INSTALLING CENTRAL MANAGEMENTTM

7.1 Central ManagementTM V8.1 Install Procedure
Requirements 
Microsoft Windows™, versions; 2000, 2003, XP Pro, Vista or Windows 7 operating systems, 
with Microsoft.NETv2.0 installed.  Windows 7 Pro-64 bit recommended.

PC Specification

The following outlines the typical Hardware requirements;

•	 Processor – 3 GHz + dual core;

•	 8GB RAM 

•	 PCI-e “dual display” graphics Controller;

•	 Tower case c/w 750W ATX power supply;

•	 DVD/CD-RW Internal, 22x dual layer SATA drive;

•	 Card Reader USB 2.0  cf/sm/sd;

•	 2 TB SATA Hard Disk;

•	 Optional Serial Port (Com1: for CMP3000 CCS);

•	 USB Ports;

•	 104 Key US keyboard ;

•	 Battery backed-up real time clock;

•	 Optical Bus mouse PS2/USB;

•	 Onboard Ethernet, 1000 BaseT, for Chamber Network;

•	 PCI-e Ethernet Card, 1000 BaseT,  for Building Network;

•	 CSA /UL CE Certified system;

•	 19” LCD Color Monitor;

•	 Y2K hardware + BIOS compliance

BIOS Selection: Password protection for CMOS parameters

Setting Options

•	 Ensure hardware meets or exceeds to Conviron Specification, above.

•	 Hard drive is partitioned to C=75% and D=25%.

•	 NIC boot roms should be disabled.

•	 PC must be configured to automatically restart, in the event of a power loss (power on 
resume). BIOS settings similar to “LAST STATE” are required.
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DVD Installation

The software has two 
requirements. The login ID of the 
first user is to be “conviron” and 
this user must have local machine 
administration privileges.

Insert the Central Management™ v8.1 DVD supplied by Conviron, into your CDROM drive. If 
auto-run is active a read me file will be displayed. If the CD does not auto-run, open the CD 
with Windows Explorer and open the file ReadMe1st.txt.

Always install the Central Management™ application in the default “C:\Program 
Files (x86)” or “C:\Program Files”location. Not following this recommendation will 
cause issues, particularly with computers using alternate languages.

A.	Set TCP/IP address for ON-Board Ethernet (Chamber Network) as indicated by the 
installation program. (Typically address 192.168.0.100 and netmask 255.255.255.0)

B.	A second Network card (Building Network) can be enabled and must be configured by 
on site I.T. staff to be used on the local building network.

C.	Install the current version of Adobe Reader to be able to view the Conviron 
Operator’s Manuals.

D.	Refer to Chapter 6.0 of the Central ManagementTM Operator’s Manual to set 
appropriate firewall rules for your installation.

E.	Go to “Starting Central Management” in Chapter 2.0 of the Central ManagementTM 
Operator’s Manual for Installation verification.

Figure 7.1: Software Installation DVD
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Activation
Central Management™ Software 
will operate as TrialWare and will 
expire in 30 days, after which a 
license file is needed to continue 
using it. You can activate Central 
Management™ at any time, by 
running “Help-About-License”. 

Copy and send the machine ID via 
email or phone by contacting Conviron at:  

centralmanagement@conviron.com or phone 204-786-6451

Conviron will supply a license file, copy it into the Central ManagementTM installation 
directory C:\Program Files (x86)\CM.

Starting
Run Central Management™ Program by double-clicking on the desktop icon titled 

Central ManagementTM  or click on Central ManagementTM in Start menu – Conviron group.
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GLOSSARY
Building Network The existing premise computer network

Cascade To arrange open windows on the desktop so that they 
overlap each other

CCS Central Control system – legacy chamber  
monitoring program

Central ManagementTM Application software designed by Conviron for total 
Phytotron management 

Central ManagementTM network The physical connection of growth chambers to the 
central control computer

Cell The smallest unit of information on a program table

Chamber The growth chamber unit, including the Controller, 
growth area, and control systems

Chamber program A series of time lines which are entered into the 
program table telling the Controller how to set 
conditions in the growth chamber over a 24-hour period

CMP Conviron Microprocessor Programmer

Controller The computer that sets, directs, and records the 
conditions in the growth chamber

Conviron Restore Drive
(Solid State Drive)

Solid State Hard Drive permitting a Bootable Windows 
7 Repair system including the Operating System Image 
and the lastest CM application data backup.

DCS Dry Contact System; relay contacts for alarm 
indications to auxiliary systems

Download Sending data to the Central ManagementTM system 
from a chamber Controller

Ethernet The type of local area network used by the Central 
ManagementTM system to connect to the chambers
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Export To copy and convert a file to a different format so that 
it can be opened by another application

Extract To copy or display selected records

Host The Central Control System - legacy chamber 
monitoring program.

Icon A small graphic that represents a Windows element 
such as a program, directory, file, window, etc.

Import To open and convert a file that has a format different 
from an application’s standard format.

Label The name used by the Controller for an output or alarm.

Load To install software.

LCS Local control system or Conviron chamber Controller

Menu bar The horizontal bar located near the top of the program 
window containing the program’s menus. You can access 
all of the programs commands from the menu bar.

Output Switches that control specific equipment or conditions 
within the chamber.

Phytotron A controlled environment facility with plant growth 
chambers and / or controlled greenhouses for  
scientific research.

Program spreadsheet See program table.

Program table A series of columns and rows for entering program 
time lines on the chamber’s Program Spreadsheet or 
the VC’s Program Editor.

Reinstall To run an application software installation after it has 
been completely removed.

Remote control Chamber operations remotely via the Remote Control 
software, for Programming and Schedule operations.
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Restore Complete operating system and application 
replacement to an image created at an earlier date. A 
fast complete recovery method.

Software repair Conviron applications use Windows Installer (MSI) 
technology which permits dynamic application repair.

Thumbnail An icon located in the Central ManagementTM system 
or Web Reporting’s Chamber Status window that 
display the current conditions of a growth chamber 
connected to the network.

Toolbar The horizontal bar located near the top of the program 
window containing icons for commonly used commands.

Upgrade Loading a new software version.

Upload Sending data from a chamber Controller to the Central 
ManagementTM system.

Virtual chamber Chamber operations using the chamber touch screen 
remotely via the VC software, “viewing” the actual 
chamber screens in real time.

Zone An area of the growth chamber that is controlled and/
or monitored by the Controller.
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